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Chapter 1

Common Test User’s Guide

Common Test is a portable application for automated testing. It is suitable for black-box testing of target
systems of any type (i.e. not necessarily implemented in Erlang), as well as for white-box testing of
Erlang/OTP programs. Black-box testing is performed via standard O&M interfaces (such as SNMP,
HTTP, Corba, Telnet, etc) and, if required, via user specific interfaces (often called test ports).
White-box testing of Erlang/OTP programs is easily accomplished by calling the target API functions
directly from the test case functions. Common Test also integrates usage of the OTP cover tool for code
coverage analysis of Erlang/OTP programs.

Common Test executes test suite programs automatically, without operator interaction. Test progress
and results is printed to logs on HTML format, easily browsed with a standard web browser. Common
Test also sends notifications about progress and results via an OTP event manager to event handlers
plugged in to the system. This way users can integrate their own programs for e.g. logging, database
storing or supervision with Common Test.

Common Test provides libraries that contain useful support functions to fill various testing needs and
requirements. There is for example support for flexible test declarations by means of so called test
specifications. There is also support for central configuration and control of multiple independent test
sessions (towards different target systems) running in parallel.

Common Test is implemented as a framework based on the OTP Test Server application.

1.1 Common Test Basics

1.1.1 Introduction

The Common Test framework (CT) is a tool which can support implementation and automated
execution of test cases towards different types of target systems. The framework is based on the OTP
Test Server. Test cases can be run individually or in batches. Common Test also features a distributed
testing mode with central control and logging. This feature makes it possible to test multiple systems
independently in one common session. This can be very useful e.g. for running automated large-scale
regression tests.

The SUT (system under test) may consist of one or several target nodes. CT contains a generic test
server which together with other test utilities is used to perform test case execution. It is possible to
start the tests from the CT GUI or from an OS- or Erlang shell prompt. Test suites are files (Erlang
modules) that contain the test cases (Erlang functions) to be executed. Support modules provide
functions that the test cases utilize in order to carry out the tests.

1Common Test
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The main idea is that CT based test programs connect to the target system(s) via standard O&M
interfaces. CT provides implementations and wrappers of some of these O&M interfaces and will be
extended with more interfaces later. There are a number of target independent interfaces supported in
CT such as Generic Telnet, FTP etc. which can be specialized or used directly for controlling
instruments, traffic generators etc.

For white-box testing of Erlang code, the test programs can of course call Erlang API functions directly.
Black-box testing of Erlang code can use Erlang RPC as well as standard O&M interfaces if desired.

A test case can handle several connections towards one or several target systems, instruments and traffic
generators in parallel in order to perform the necessary actions for a test. The handling of many
connections in parallel is one of the major strengths of CT!

1.1.2 Test Suite Organisation

The test suites are organized in test directories and each test suite may have a separate data directory.
Typically, these files and directories are version controlled similarly to other forms of source code
(possibly by means of some CVS-like tool). However, CT does not itself put any requirements on (or
has any form of awareness of) possible file and directory versions.

1.1.3 Support Libraries

Support libraries are functions that are useful for all test suites or for test suites in a specific functional
area or subsystem. So as well as the general support libraries provided by the CT framework there
might be a need for customized support libraries on a subsystem level.

1.1.4 Scripting Suite and Test Cases

Testing is performed by running test suites (a set of test cases) or individual test cases. A test suite is
implemented as an Erlang module named <suite name> SUITE.erl which contains a number of test
cases. A test case is an Erlang function which tests one or more things. The test case is the smallest unit
that the CT test server deals with.

The test suite file must conform to a certain interface which is specified by the CT test server. See the
section on writing test suites for more information.

A test case is considered successful if it returns to the caller, no matter what the returned value is. A
few return values have special meaning however (such as fskip,Reasong which indicates that the test
case is skipped, fcomment,Commentg which prints a comment in the log for the test case and
fsave config,Configg which makes the CT test server pass Config to the next test case). A test case
failure is specified as a runtime error (a crash), no matter what the reason for termination is. If you use
Erlang pattern matching effectively, you can take advantage of this property. The result will be concise
and readable test case functions that look much more like scripts than actual programs. Simple example:

session( Config) ->
fstarted,ServerIdg = my server:start(),
fclients,[]g = my server:get clients(ServerId),
MyId = self(),
connected = my server:connect(ServerId, MyId),
fclients,[MyId]g = my server:get clients(ServerId),
disconnected = my server:disconnect(ServerId, MyId),
fclients,[]g = my server:get clients(ServerId),
stopped = my server:stop(ServerId).
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As a test suite runs, all information (including output to stdout) is recorded in several different log files.
A minimum of information is displayed in the user console (only start and stop information, plus a note
for each failed test case).

The result from each test case is recorded in an HTML log file which is created for the particular test
run. Each test case is represented by a row in a table that shows the total execution time, whether the
case was successful or if it failed or was skipped, plus a possible user comment. For a failed test case, the
reason for termination is printed. The HTML file has a link to the logfile for each test case (which may
also be viewed with an HTML browser).

1.1.5 External Interfaces

The CT test server requires some default functions in a test suite. Each suite module should define and
export the following functions (most are however optional):

all() Returns a list of all test cases in the suite. (Mandatory)

suite() Default suite configuration. (Optional)

groups() For declaring test case groups. (Optional)

init per suite(Config) Executed before the first test case in a suite. (Optional)

end per suite(Config) Executed after the last test case in a suite. (Optional)

init per group(Config) Executed before the first test case in a group. (Optional)

end per group(Config) Executed after the last test case in a group. (Optional)

init per testcase(TC, Config) Executed before each test case. (Optional)

end per testcase(TC, Config) Executed after each test case. (Optional)

For each test case the CT test server needs these functions:

Testcasename() Returns a key-value list of test case configuration/information. (Optional)

Testcasename(Config) The actual test case function.

1.2 Installation

1.2.1 Unix

Copy the Common Test and Test Server application directories, common test-<vsn> and
test server-<vsn>, to a location of your choice. They do not have to be placed among the Erlang
applications under the OTP lib directory, nor do they need to have a particular path relative to your test
suite modules. In the Common Test directory you find the shell script install.sh. Execute this script
to generate the Common Test start script run test in the sub directory
common test-<vsn>/priv/bin.

install.sh takes one input parameter which specifies the absolute path to the top directory of
Common Test and Test Server. (This path is inserted in the run test script so that when the script
starts Erlang, the Erlang code server will be able to load the Common Test and Test Server application
modules). Example (assuming Common Test and Test Server have been placed in
/usr/local/test tools):

$ install.sh /usr/local/test tools
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Note that the common test-<vsn> and test server-<vsn> directories must be located under the
same top directory for the installation to work properly. Note also that the install script does not e.g.
copy files or update environment variables. It only generates the run test script.

If the directories are later moved, make sure to run install.sh again or edit the run test script
(Bourne shell) manually.

For more information on the run test script, please see the reference manual.

1.2.2 Windows

On Windows it is very convenient to use Cygwin (www.cygwin.com) for running Common Test and
Erlang, since it enables you to use the run test script for starting Common Test. If you are a Cygwin
user, simply follow the instructions for installing Common Test on Unix above.

If you do not use Cygwin, you have to rely on the API functions in the ct module (instead of run test)
for running Common Test. In this case you do not need to install Common Test (i.e. no need to
generate the run test script). Simply copy the common test-<vsn> and test server-<vsn>
directories to a location of your choice. They do not have to be placed among the Erlang applications
under the OTP lib directory, nor do they need to have a particular path relative to your test suite
modules.

When you start the Erlang node on which you will be running Common Test, make sure the Common
Test and Test Server ebin directories are included in the Erlang code server path (so the application
modules can be loaded). If you do copy the application directories to the OTP lib directory, there is no
need to explicitly update the code server path as the code server will be able to locate the modules
automatically.

1.3 Writing Test Suites

1.3.1 Support for test suite authors

The ct module provides the main interface for writing test cases. This includes:

� Functions for printing and logging

� Functions for reading configuration data

� Function for terminating a test case with error reason

� Function for adding comments to the HTML overview page

� Tracing of line numbers in the test suite, i.e. if a test case fails, the last 10 executed line numbers
are displayed

Please see the reference manual for the ct module for details about these functions.

The CT application also includes other modules named ct <something> that provide support for the
use of communication mechanisms such as rpc, snmp, ftp, telnet etc in test suites.
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1.3.2 Test suites

A test suite is an ordinary Erlang module that contains test cases. It is recommended that the module
has a name on the form * SUITE.erl. Otherwise, the directory function in CT will not be able to
locate the modules (per default).

ct.hrl shall be included in all test suite files.

Each test suite module must export the function all/0 which returns the list of all test case groups and
test cases in that module.

1.3.3 Init and end per suite

Each test suite module may contain the functions init per suite/1 and end per suite/1.

If it exists, init per suite is called as the first testcase of the suite. It typically contains initializations
that are common for all test cases in the suite, and that are only to be performed once.

end per suite is called as the last test case of the suite. This function should clean up after
init per suite.

The argument to init per suite is Config, the same as the argument to all test cases. init per suite
can modify this parameter with information that the other test cases need.

If init per suite fails, all test cases in the test suite will be skipped, including end per suite.

1.3.4 Init and end per test case

Each test suite module can contain the functions init per testcase/2 and end per testcase/2.

If it exists, init per testcase is called before each test case in the suite. It typically contains initiation
which must be done for each test case.

end per testcase/2 is called after each test case is completed, giving a possibility to clean up.

The first argument to these functions is the name of the test case. This can be used to do individual
initiation and cleanup for each test cases.

The second argument is called Config. init per testcase/2 may modify this parameter or just return
it as is. Whatever is retuned by init per testcase/2 is given as Config parameter to the test case
itself.

The return value of end per testcase/2 is ignored by the test server (with exception of the save config
[page 41] tuple).

It is possible in end per testcase to check if the test case was successful or not (which consequently
may determine how cleanup should be performed). This is done by reading the value tagged with
tc status from Config. The value is either ok, ffailed,Reasong, or fskipped,Reasong.

If init per testcase crashes, the test case itself is skipped and end per testcase is never called.
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1.3.5 Test cases

The smallest unit that the test server is concerned with is a test case. Each test case can in turn test
many things, for example make several calls to the same interface function with different parameters.

It is possible to put many or few tests into each test case. How many things each test case does is of
course up to the author, but here are some things to keep in mind:

Using many small test cases tend to result in extra and often duplicated code as well as slow test
execution because of large overhead for initializations and cleanups. Lots of duplicated code results in
high maintenance cost and bad readability.

Larger test cases make it harder to tell what went wrong if it fails, and large portions of test code will be
skipped if a specific part fails. Also, readability and maintainability suffers when test cases become too
extensive.

The test case function takes one argument, Config, which contains configuration information such as
data dir and priv dir. See Data and Private Directories [page 12] for more information about these.

Note:
The test case function argument Config should not be confused with the information that can be
retrieved from configuration files (using ct:get config/[1,2]). The Config argument should be used for
runtime configuration of the test suite and the test cases. A configuration file should contain data
related to the SUT (system under test). These two types of config data are handled differently!

All Config items can be extracted using the ?config macro, e.g PrivDir =
?config(priv dir,Config).

If the test case function crashes or exits, it is considered a failure. If it returns a value (no matter what
actual value) it is considered a success. An exception to this rule is the return value fskip,Reasong. If
this is returned, the test case is considered skipped and gets logged as such.

If the test case returns the tuple fcomment,Commentg, Comment is printed out in the overview log (this is
equal to calling ct:comment(Comment)).

1.3.6 Test case info function

For each test case function there can be an additional function with the same name but with no
arguments. This is the test case info function. The test case info function is expected to return a list of
tagged tuples that specifies various properties regarding the test case.

The following tags have special meaning:

timetrap Set the maximum time the test case is allowed to take. If the timetrap time is exceeded, the
test case fails with reason timetrap timeout. Note that init per testcase and
end per testcase are included in the timetrap time.

userdata Use this to specify arbitrary data related to the testcase. This data can be retrieved at any
time using the ct:userdata/3 utility function.

silent connections Please see the Silent Connections [page 26] chapter for details.
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require Use this to specify configuration variables that are required by the test case. If the required
configuration variables are not found in any of the test system configuration files, the test case is
skipped.
It is also possible to give a required variable a default value that will be used if the variable is not
found in any configuration file. To specify a default value, add a tuple on the form:
fdefault config,ConfigVariableName,Valueg to the test case info list (the position in the list
is irrelevant). Examples:

testcase1() ->
[frequire, ftpg,
fdefault config, ftp, [fftp, "my ftp host"g,

fusername, "alladin"g,
fpassword, "sesame"g]gg].

testcase2() ->
[frequire, unix telnet, funix, [telnet, username, password]gg,
fdefault config, unix, [ftelnet, "my telnet host"g,

fusername, "alladin"g,
fpassword, "sesame"g]gg].

See the Config files [page 28] chapter and the ct:require/[1,2] function in the ct [page 64]
reference manual for more information about require.

Note:
Specifying a default value for a required variable can result in a test case always getting executed.
This might not be a desired behaviour!

If timetrap and/or require is not set specifically for a particular test case, default values specified by
the suite/0 function are used.

Other tags than the ones mentioned above will simply be ignored by the test server.

Example:

reboot node() ->
[
ftimetrap,fseconds,60gg,
frequire,interfacesg,
fuserdata,

[fdescription,"System Upgrade: RpuAddition Normal RebootNode"g,
ffts,"http://someserver.ericsson.se/test doc4711.pdf"g]g

].

7Common Test



Chapter 1: Common Test User’s Guide

1.3.7 Test suite info function

The suite/0 function can be used in a test suite module to set the default values for the timetrap and
require tags. If a test case info function also specifies any of these tags, the default value is overruled.
See above for more information.

Other options that may be specified with the suite info list are:

� stylesheet, see HTML Style Sheets [page 24].

� userdata, see Test case info function [page 6].

� silent connections, see Silent Connections [page 26].

Example:

suite() ->
[
ftimetrap,fminutes,10gg,
frequire,global namesg,
fuserdata,[finfo,"This suite tests database transactions."g]g,
fsilent connections,[telnet]g,
fstylesheet,"db testing.css"g

].

1.3.8 Test case groups

A test case group is a set of test cases that share configuration functions and execution properties. Test
case groups are defined by means of the groups/0 function according to the following syntax:

groups() -> GroupDefs

Types:

GroupDefs = [GroupDef]
GroupDef = fGroupName,Properties,GroupsAndTestCasesg
GroupName = atom()
GroupsAndTestCases = [GroupDef | fgroup,GroupNameg | TestCase]
TestCase = atom()

GroupName is the name of the group and should be unique within the test suite module. Groups may be
nested, and this is accomplished simply by including a group definition within the
GroupsAndTestCases list of another group. Properties is the list of execution properties for the
group. The possible values are:

Properties = [parallel | sequence | Shuffle | fRepeatType,Ng]
Shuffle = shuffle | fshuffle,Seedg
Seed = finteger(),integer(),integer()g
RepeatType = repeat | repeat until all ok | repeat until all fail |

repeat until any ok | repeat until any fail
N = integer() | forever
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If the parallel property is specified, Common Test will execute all test cases in the group in parallel. If
sequence is specified, the cases will be executed in a sequence, as described in the chapter
Dependencies between test cases and suites [page 42]. If shuffle is specified, the cases in the group
will be executed in random order. The repeat property orders Common Test to repeat execution of the
cases in the group a given number of times, or until any, or all, cases fail or succeed.

Example:

groups() -> [fgroup1, [parallel], [test1a,test1b]g,
fgroup2, [shuffle,sequence], [test2a,test2b,test2c]g].

To specify in which order groups should be executed (also with respect to test cases that are not part of
any group), tuples on the form fgroup,GroupNameg should be added to the all/0 list. Example:

all() -> [testcase1, fgroup,group1g, testcase2, fgroup,group2g].

Properties may be combined so that e.g. if shuffle, repeat until any fail and sequence are all
specified, the test cases in the group will be executed repeatedly and in random order until a test case
fails, when execution is immediately stopped and the rest of the cases skipped.

Before execution of a group begins, the configuration function init per group(GroupName, Config)
is called. The list of tuples returned from this function is passed to the test cases in the usual manner by
means of the Config argument. init per group/2 is meant to be used for initializations common for
the test cases in the group. After execution of the group is finished, the end per group(GroupName,
Config function is called. This function is meant to be used for cleaning up after init per group/2.

Note:
init per testcase/2 and end per testcase/2 are always called for each individual test case, no
matter if the case belongs to a group or not.

The properties for a group is always printed on the top of the HTML log for init per group/2. Also,
the total execution time for a group can be found at the bottom of the log for end per group/2.

Test case groups may be nested so that sets of groups can be configured with the same
init per group/2 and end per group/2 functions. Nested groups may be defined by including a group
definition, or a group name reference, in the test case list of another group. Example:

groups() -> [fgroup1, [shuffle], [test1a,
fgroup2, [], [test2a,test2b]g,
test1b]g,

fgroup3, [], [fgroup,group4g,
fgroup,group5g]g,

fgroup4, [parallel], [test4a,test4b]g,
fgroup5, [sequence], [test5a,test5b,test5c]g].

In the example above, if all/0 would return group name references in this order:
[fgroup,group1g,fgroup,group3g], the order of the configuration functions and test cases will be the
following (note that init per testcase/2 and end per testcase/2: are also always called, but not
included in this example for simplification):
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- init per group(group1, Config) -> Config1 (*)

-- test1a(Config1)

-- init per group(group2, Config1) -> Config2

--- test2a(Config2), test2b(Config2)

-- end per group(group2, Config2)

-- test1b(Config1)

- end per group(group1, Config1)

- init per group(group3, Config) -> Config3

-- init per group(group4, Config3) -> Config4

--- test4a(Config4), test4b(Config4) (**)

-- end per group(group4, Config4)

-- init per group(group5, Config3) -> Config5

--- test5a(Config5), test5b(Config5), test5c(Config5)

-- end per group(group5, Config5)

- end per group(group3, Config3)

(*) The order of test case test1a, test1b and group2 is not actually
defined since group1 has a shuffle property.

(**) These cases are not executed in order, but in parallel.

Properties are not inherited from top level groups to nested sub-groups. E.g, in the example above, the
test cases in group2 will not be executed in random order (which is the property of group1).

1.3.9 The parallel property and nested groups

If a group has a parallel property, its test cases will be spawned simultaneously and get executed in
parallel. A test case is not allowed to execute in parallel with end per group/2 however, which means
that the time it takes to execute a parallel group is equal to the execution time of the slowest test case
in the group. A negative side effect of running test cases in parallel is that the HTML summary pages
are not updated with links to the individual test case logs until the end per group/2 function for the
group has finished.

A group nested under a parallel group will start executing in parallel with previous (parallel) test cases
(no matter what properties the nested group has). Since, however, test cases are never executed in
parallel with init per group/2 or end per group/2 of the same group, it’s only after a nested group
has finished that any remaining parallel cases in the previous group get spawned.

10 Common Test



1.3: Writing Test Suites

1.3.10 Repeated groups

A test case group may be repeated a certain number of times (specified by an integer) or indefinitely
(specified by forever). The repetition may also be stopped prematurely if any or all cases fail or
succeed, i.e. if the property repeat until any fail, repeat until any ok, repeat until all fail,
or repeat until all ok is used. If the basic repeat property is used, status of test cases is irrelevant
for the repeat operation.

It is possible to return the status of a sub-group (ok or failed), to affect the execution of the group on
the level above. This is accomplished by, in end per group/2, looking up the value of
tc group properties in the Config list and checking the result of the test cases in the group. If status
failed should be returned from the group as a result, end per group/2 should return the value
freturn group result,failedg. The status of a sub-group is taken into account by Common Test
when evaluating if execution of a group should be repeated or not (unless the basic repeat property is
used).

The tc group properties value is a list of status tuples, each with the key ok, skipped and failed.
The value of a status tuple is a list containing names of test cases that have been executed with the
corresponding status as result.

Here’s an example of how to return the status from a group:

end per group( Group, Config) ->
Status = ?config(tc group result, Config),
case proplists:get value(failed, Status) of

[] -> % no failed cases
freturn group result,okg;

Failed -> % one or more failed
freturn group result,failedg

end.

It is also possible in end per group/2 to check the status of a sub-group (maybe to determine what
status the current group should also return). This is as simple as illustrated in the example above, only
the name of the group is stored in a tuple fgroup result,GroupNameg, which can be searched for in
the status lists. Example:

end per group(group1, Config) ->
Status = ?config(tc group result, Config),
Failed = proplists:get value(failed, Status),
case lists:member(fgroup result,group2g, Failed) of

true ->
freturn group result,failedg;

false ->
freturn group result,okg

end;
...

Note:
When a test case group is repeated, the configuration functions, init per group/2 and
end per group/2, are also always called with each repetition.
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1.3.11 Shuffled test case order

The order that test cases in a group are executed, is under normal circumstances the same as the order
specified in the test case list in the group definition. With the shuffle property set, however, Common
Test will instead execute the test cases in random order.

The user may provide a seed value (a tuple of three integers) with the shuffle property:
fshuffle,Seedg. This way, the same shuffling order can be created every time the group is executed. If
no seed value is given, Common Test creates a “random” seed for the shuffling operation (using the
return value of erlang:now()). The seed value is always printed to the init per group/2 log file so
that it can be used to recreate the same execution order in a subsequent test run.

Note:
If a shuffled test case group is repeated, the seed will not be reset in between turns.

If a sub-group is specified in a group with a shuffle property, the execution order of this sub-group in
relation to the test cases (and other sub-groups) in the group, is also random. The order of the test cases
in the sub-group is however not random (unless, of course, the sub-group also has a shuffle property).

1.3.12 Data and Private Directories

The data directory (data dir) is the directory where the test module has its own files needed for the
testing. The name of the data dir is the the name of the test suite followed by " data". For example,
"some path/foo SUITE.beam" has the data directory "some path/foo SUITE data/".

The priv dir is the test suite’s private directory. This directory should be used when a test case needs
to write to files. The name of the private directory is generated by the test server, which also creates the
directory.

Note:
You should not depend on current working directory for reading and writing data files since this is
not portable. All scratch files are to be written in the priv dir and all data files should be located in
data dir. If you do need to use the current working directory, you must set it explicitly with
file:set cwd/1 for each individual test case before use. (The Common Test server sets current
working directory to the test case log directory at the start of every case).

1.3.13 Execution environment

Each test case, including init per testcase and end per testcase is executed by a dedicated Erlang
process. The process is spawned when the test case starts, and terminated when the test case is finished.

init per suite and end per suite are separate test cases and will execute on their own processes.

The default time limit for a test case is 30 minutes, unless a timetrap is specified either by the test case
info function or by the suite/0 function.
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1.3.14 Illegal dependencies

Even though it is highly efficient to write test suites with the Common Test framework, there will be
mistakes in the test suites. Noted below are some of the more frequent dependency mistakes from our
experience with running the Erlang/OTP test suites.

� Depending on current directory, and writing there:
This is a common error in test suites. It is assumed that the current directory is the same as what
the author used as current directory when the test case was developed. Many test cases even try to
write scratch files to this directory. If the current directory has to be set to something in particular,
use file:set cwd/1 to set it. And use the data dir and priv dir to locate data and scratch files.

� Depending on the Clearcase (file version control tool) paths and files:
The test suites are stored in Clearcase but are not (necessarily) run within this environment. The
directory structure may vary from test run to test run.

� Depending on execution order:
There is no way of telling in which order the test cases are going to be run, so a test case can’t
depend on a server being started by a test case that runs “before”. This has to be so for several
reasons:
The user may specify the order at will, and maybe some particular order is better suited
sometimes. Secondly, if the user just specifies a test directory, the order the suites are executed
will depend on how the files are listed by the operating system, which varies between systems.
Thirdly, if a user wishes to run only a subset of a test suite, there is no way one test case could
successfully depend on another.

� Depending on Unix:
Running unix commands through unix:cmd or os:cmd are likely not to work on non-unix
platforms.

� Nested test cases:
Invoking a test case from another not only tests the same thing twice, but also makes it harder to
follow what exactly is being tested. Also, if the called test case fails for some reason, so will the
caller. This way one error gives cause to several error reports, which is less than ideal.
Functionality common for many test case functions may be implemented in common help
functions. If these functions are useful for test cases across suites, put the help functions into
common help modules.

� Failure to crash or exit when things go wrong:
Making requests without checking that the return value indicates success may be ok if the test
case will fail at a later stage, but it is never acceptable just to print an error message (into the log
file) and return successfully. Such test cases do harm since they create a false sense of security
when overviewing the test results.

� Messing up for following test cases:
Test cases should restore as much of the execution environment as possible, so that the following
test cases will not crash because of execution order of the test cases. The function
end per testcase is suitable for this.

1.4 Test Structure

1.4.1 Test structure

A test consists of a set of test cases. Each test case is implemented as an Erlang function. An Erlang
module implementing one or more test cases is called a test suite. One or more test suites are stored in
a test directory.
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1.4.2 Skipping test cases

It is possible to skip certain test cases, for example if you know beforehand that a specific test case fails.
This might be functionality which isn’t yet implemented, a bug that is known but not yet fixed or some
functionality which doesn’t work or isn’t applicable on a specific platform.

There are several different ways to state that one or more test cases should be skipped:

� Using skip suites and skip cases terms in test specifications [page 20].

� Returning fskip,Reasong from the init per testcase/2 or init per suite/1 functions.

� Returning fskip,Reasong from the execution clause of the test case.

The latter of course means that the execution clause is actually called, so the author must make sure
that the test case is not run.

When a test case is skipped, it will be noted as SKIPPED in the HTML log.

1.4.3 Definition of terms

data dir Data directory for a test suite. This directory contains any files used by the test suite, e.g.
additional Erlang modules, binaries or data files.

major log file An overview log file for one or more test suites.

minor log file A log file for one particular test case.

priv dir Private directory for a test suite. This directory should be used when the test suite needs to
write to files.

test case A single test included in a test suite. A test case is implemented as a function in a test suite
module.

test suite An erlang module containing a collection of test cases for a specific functional area.

test directory A directory that contains one or more test suite modules, i.e. a group of test suites.

1.5 Examples

1.5.1 Test suite

The example test suite shows some tests of an HTTP client that uses a proxy.

-module(httpc_proxy_SUITE).

%% Note: This directive should only be used in test suites.
-compile(export_all).

-include("ct.hrl").

-define(URL, "http://www.erlang.org").
-define(PROXY, "www-proxy.ericsson.se").
-define(PROXY_PORT, 8080).

%%--------------------------------------------------------------------
%% Test server callback functions
%%--------------------------------------------------------------------
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%%--------------------------------------------------------------------
%% Function: suite() -> DefaultData
%% DefaultData: [tuple()]
%% Description: Require variables and set default values for the suite
%%--------------------------------------------------------------------
suite() -> [{timetrap,{minutes,1}}].

%%--------------------------------------------------------------------
%% Function: init_per_suite(Config) -> Config
%% Config: [tuple()]
%% A list of key/value pairs, holding the test case configuration.
%% Description: Initiation before the whole suite
%%
%% Note: This function is free to add any key/value pairs to the Config
%% variable, but should NOT alter/remove any existing entries.
%%--------------------------------------------------------------------
init_per_suite(Config) ->

application:start(inets),
http:set_options([{proxy, {{?PROXY, ?PROXY_PORT}, ["localhost"]}}]),
Config.

%%--------------------------------------------------------------------
%% Function: end_per_suite(Config) -> _
%% Config: [tuple()]
%% A list of key/value pairs, holding the test case configuration.
%% Description: Cleanup after the whole suite
%%--------------------------------------------------------------------
end_per_suite(_Config) ->

application:stop(inets),
ok.

%%--------------------------------------------------------------------
%% Function: all() -> TestCases
%% TestCases: [Case]
%% Case: atom()
%% Name of a test case.
%% Description: Returns a list of all test cases in this test suite
%%--------------------------------------------------------------------
all() ->

[options, head, get, trace].

%%-------------------------------------------------------------------------
%% Test cases starts here.
%%-------------------------------------------------------------------------

options() ->
[{userdata,[{doc,"Perform an OPTIONS request that goes through a proxy."}]}].

options(_Config) ->
{ok, {{_,200,_}, Headers, _}} =

http:request(options, {?URL, []}, [], []),
case lists:keysearch("allow", 1, Headers) of

{value, {"allow", _}} ->
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ok;
_ ->

ct:fail(http_options_request_failed)
end.

head() ->
[{userdata,[{doc,"Perform a HEAD request that goes through a proxy."}]}].

head(_Config) ->
{ok, {{_,200, _}, [_ | _], []}} =

http:request(head, {?URL, []}, [], []).

get() ->
[{userdata,[{doc, "Perform a GET request that goes through a proxy."}]}].

get(_Config) ->
{ok, {{_,200,_}, [_ | _], Body = [_ | _]}} =

http:request(get, {?URL, []}, [], []),
check_body(Body).

trace() ->
[{userdata,[{doc, "Perform a TRACE request that goes through a proxy."}]}].

trace(_Config) ->
{ok, {{_,200,_}, [_ | _], "TRACE /" ++ _}} =

http:request(trace, {?URL, []}, [], []),
ok.

%%--------------------------------------------------------------------
%% Internal functions
%%--------------------------------------------------------------------

check_body(Body) ->
case string:rstr(Body, "\html>") of

0 ->
ct:fail(did_not_receive_whole_body);

_ ->
ok

end.

1.6 Running Test Suites

1.6.1 Using the Common Test Framework

The Common Test Framework provides a high level operator interface for testing. It adds the following
features to the Erlang/OTP Test Server:

� Automatic compilation of test suites (and help modules).

� Creation of additional HTML pages for better overview.

� Single command interface for running all available tests.

� Handling of configuration files specifying target nodes and other variables.
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� Mode for running multiple independent test sessions in parallel with central control and
configuration.

1.6.2 Automatic compilation of test suites and help modules

When Common Test starts, it will automatically attempt to compile any suites included in the specified
tests. If particular suites have been specified, only those suites will be compiled. If a particular test
object directory has been specified (meaning all suites in this directory should be part of the test),
Common Test runs make:all/1 in the directory to compile the suites.

If compilation should fail for one or more suites, the compilation errors are printed to tty and the
operator is asked if the test run should proceed without the missing suites, or be aborted. If the
operator chooses to proceed, it is noted in the HTML log which tests have missing suites.

Any help module (i.e. regular Erlang module with name not ending with “ SUITE”) that resides in the
same test object directory as a suite which is part of the test, will also be automatically compiled. A
help module will not be mistaken for a test suite (unless it has a “ SUITE” name of course). All help
modules in a particular test object directory are compiled no matter if all or only particular suites in the
directory are part of the test.

If test suites or help modules include header files stored in other locations than the test directory, you
may specify these include directories by means of the -include flag with run test, or the include
option with ct:run test/1. In addition to this, an include path may be specified with an OS
environment variable; CT INCLUDE PATH. Example (bash):

$ export
CT INCLUDE PATH=~testuser/common suite files/include:~testuser/common lib files/include

Common Test will pass all include directories (specified either with the include flag/option, or the
CT INCLUDE PATH variable, or both) to the compiler.

It is also possible to specify include directories in test specifications (see below).

It is possible to disable the automatic compilation feature by using the -no auto compile flag with
run test, or the fauto compile,falseg option with ct:run test/1. With automatic compilation
disabled, the user is responsible for compiling the test suite modules (and any help modules) before the
test run. Common Test will only verify that the specified test suites exist before starting the tests.

1.6.3 Running tests from the UNIX command line

The script run test can be used for running tests from the UNIX command line, e.g.

� run test -config <configfilenames> -dir <dirs>

� run test -config <configfilenames> -suite <suiteswithfullpath>

� run test -config <configfilenames> -suite <suitewithfullpath> -group
<groupnames> -case <casenames>

Examples:

$ run test -config $CFGS/sys1.cfg $CFGS/sys2.cfg -dir $SYS1 TEST $SYS2 TEST

$ run test -suite $SYS1 TEST/setup SUITE $SYS2 TEST/config SUITE

$ run test -suite $SYS1 TEST/setup SUITE -case start stop

$ run test -suite $SYS1 TEST/setup SUITE -group installation -case start stop

Other flags that may be used with run test:

� -logdir <dir>, specifies where the HTML log files are to be written.
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� -refresh logs, refreshes the top level HTML index files.

� -vts, start web based GUI (see below).

� -shell, start interactive shell mode (see below).

� -step [step opts], step through test cases using the Erlang Debugger (see below).

� -spec <testspecs>, use test specification as input (see below).

� -allow user terms, allows user specific terms in a test specification (see below).

� -silent connections [conn types], tells Common Test to suppress printouts for specified
connections (see below).

� -stylesheet <css file>, points out a user HTML style sheet (see below).

� -cover <cover cfg file>, to perform code coverage test (see Code Coverage Analysis [page
31]).

� -event handler <event handlers>, to install event handlers [page 35].

� -include, specifies include directories (see above).

� -no auto compile, disables the automatic test suite compilation feature (see above).

� -repeat <n>, tells Common Test to repeat the tests n times (see below).

� -duration <time>, tells Common Test to repeat the tests for duration of time (see below).

� -until <stop time>, tells Common Test to repeat the tests until stop time (see below).

� -force stop, on timeout, the test run will be aborted when current test job is finished (see
below).

� -decrypt key <key>, provides a decryption key for encrypted configuration files [page 29].

� -decrypt file <key file>, points out a file containing a decryption key for encrypted
configuration files [page 29].

1.6.4 Running tests from the Web based GUI

The web based GUI, VTS, is started with the run test script. From the GUI you can load config files,
and select directories, suites and cases to run. You can also state the config files, directories, suites and
cases on the command line when starting the web based GUI.

� run test -vts

� run test -vts -config <configfilename>

� run test -vts -config <configfilename> -suite <suitewithfullpath> -case
<casename>

From the GUI you can run tests and view the result and the logs.

Note that run test -vts will try to open the Common Test start page in an existing web browser
window or start the browser if it is not running. Which browser should be started may be specified with
the browser start command option:

run test -vts -browser <browser start cmd>

Example:

$ run test -vts -browser ’firefox-2.0.0.3&’

Note that the browser must run as a separate OS process or VTS will hang!

If no specific browser start command is specified, netscape will be the default browser on UNIX
platforms and Internet Explorer on Windows. For the VTS mode to work properly with netscape, make
sure the netscape program in your path starts version 7!
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1.6.5 Running tests from the Erlang shell

Common Test provides an Erlang API for running tests. For documentation, please see the ct manual
page.

1.6.6 Running interactive shell mode

You can start an Erlang shell with the necessary paths and with Common Test running in an interactive
mode with the run test script and the -shell option:

� run test -shell

� run test -shell -config <configfilename>

If no config file is given with the run test command, a warning will be displayed. If Common Test has
been run from the same directory earlier, the same config file(s) will be used again. If Common Test has
not been run from this directory before, no config files will be available.

From the interactive mode all test case support functions can be executed directly from the erlang shell.
This is an experimentation mode useful during test suite development and debugging.

If any functions using “required config data” (e.g. telnet or ftp functions) are to be called from the
erlang shell, config data must first be required with ct:require/[1,2]. This is equivalent to a require
statement in the Test Suite Info Function [page 8] or in the Test Case Info Function [page 6].

Example:

> ct:require(a,funix,[telnet]g).
ok
> ct:cmd(a,"ls").
fok,["ls","file1 ...",...]g

Everything that Common Test normally prints in the test case logs, will in the interactive mode be
written to a log named ctlog.html in the ct run.<timestamp> directory. A link to this file will be
available in the file named last interactive.html in the directory from which you executed
run test.

If you for some reason want to exit the interactive mode, use the function ct:stop interactive/0.
This shuts down the running ct application. Associations between configuration names and data
created with require are consequently deleted. ct:start interactive/0 will get you back into
interactive mode, but previous state is not restored.

1.6.7 Step by step execution of test cases with the Erlang Debugger

By means of run test -step [opts], or by passing the fstep,Optsg option to ct:run test/1, it is
possible to get the Erlang Debugger started automatically and use its graphical interface to investigate
the state of the current test case and to execute it step by step and/or set execution breakpoints.

If no extra options are given with the step flag/option, breakpoints will be set automatically on the test
cases that are to be executed by Common Test, and those functions only. If the step option config is
specified, breakpoints will also be initially set on the configuration functions in the suite, i.e.
init per suite/1, end per suite/1, init per testcase/2 and end per testcase/2.

Common Test enables the Debugger auto attach feature, which means that for every new interpreted
test case function that starts to execute, a new trace window will automatically pop up. (This is because
each test case executes on a dedicated Erlang process). Whenever a new test case starts, Common Test
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will attempt to close the inactive trace window of the previous test case. However, if you prefer that
Common Test leaves inactive trace windows, use the keep inactive option.

The step functionality can be used together with the suite and the suite + case/testcase
flag/option, but not together with dir.

1.6.8 Using test specifications

The most expressive way to specify what to test is to use a so called test specification. A test
specification is a sequence of Erlang terms. The terms may be declared in a text file or passed to the test
server at runtime as a list (see run testspec/1 in the manual page for ct). There are two general types
of terms; configuration terms and test specification terms.

With configuration terms it is possible to import configuration data (similar to run test -config),
specify HTML log directories (similar to run test -logdir), give aliases to test nodes and test
directories (to make a specification easier to read and maintain), enable code coverage analysis (see the
Code Coverage Analysis [page 31] chapter) and specify event handler plugins (see the Event Handling
[page 35] chapter). There is also a term for specifying include directories that should be passed on to
the compiler when automatic compilation is performed (similar to run test -include, see above).

With test specification terms it is possible to state exactly which tests should run and in which order. A
test term specifies either one or more suites or one or more test cases. An arbitrary number of test terms
may be declared in sequence. A test term can also specify one or more test suites or test cases to be
skipped. Skipped suites and cases are not executed and show up in the HTML test log as SKIPPED.

Note:
It is not yet possible to specify test case groups in test specifications. This will be supported in a soon
upcoming release.

Below is the test specification syntax. Test specifications can be used to run tests both in a single test
host environment and in a distributed Common Test environment. Node parameters are only relevant
in the latter (see the chapter about running Common Test in distributed mode for information). For
details on the event handler term, see the Event Handling [page 35] chapter.

Config terms:

fnode, NodeAlias, Nodeg.

fcover, CoverSpecFileg.
fcover, NodeRef, CoverSpecFileg.

finclude, IncludeDirsg.
finclude, NodeRefs, IncludeDirsg.

fconfig, ConfigFilesg.
fconfig, NodeRefs, ConfigFilesg.

falias, DirAlias, Dirg.

flogdir, LogDirg.
flogdir, NodeRefs, LogDirg.
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fevent handler, EventHandlersg.
fevent handler, NodeRefs, EventHandlersg.
fevent handler, EventHandlers, InitArgsg.
fevent handler, NodeRefs, EventHandlers, InitArgsg.

Test terms:

fsuites, DirRef, Suitesg.
fsuites, NodeRefs, DirRef, Suitesg.

fcases, DirRef, Suite, Casesg.
fcases, NodeRefs, DirRef, Suite, Casesg.

fskip suites, DirRef, Suites, Commentg.
fskip suites, NodeRefs, DirRef, Suites, Commentg.

fskip cases, DirRef, Suite, Cases, Commentg.
fskip cases, NodeRefs, DirRef, Suite, Cases, Commentg.

Types:

NodeAlias = atom()
Node = node()
NodeRef = NodeAlias | Node | master
NodeRefs = all nodes | [NodeRef] | NodeRef
CoverSpecFile = string()
IncludeDirs = string() | [string()]
ConfigFiles = string() | [string()]
DirAlias = atom()
Dir = string()
LogDir = string()
EventHandlers = atom() | [atom()]
InitArgs = [term()]
DirRef = DirAlias | Dir
Suites = atom() | [atom()] | all
Cases = atom() | [atom()] | all
Comment = string() | ""

Example:

flogdir, "/home/test/logs"g.

fconfig, "/home/test/t1/cfg/config.cfg"g.
fconfig, "/home/test/t2/cfg/config.cfg"g.
fconfig, "/home/test/t3/cfg/config.cfg"g.

falias, t1, "/home/test/t1"g.
falias, t2, "/home/test/t2"g.
falias, t3, "/home/test/t3"g.
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fsuites, t1, allg.
fskip suites, t1, [t1B SUITE,t1D SUITE], "Not implemented"g.
fskip cases, t1, t1A SUITE, [test3,test4], "Irrelevant"g.
fskip cases, t1, t1C SUITE, [test1], "Ignore"g.

fsuites, t2, [t2B SUITE,t2C SUITE]g.
fcases, t2, t2A SUITE, [test4,test1,test7]g.

fskip suites, t3, all, "Not implemented"g.

The example specifies the following:

� The specified logdir directory will be used for storing the HTML log files (in subdirectories tagged
with node name, date and time).

� The variables in the specified test system config files will be imported for the test.

� Aliases are given for three test system directories. The suites in this example are stored in
“/home/test/tX/test”.

� The first test to run includes all suites for system t1. Excluded from the test are however the t1B
and t1D suites. Also test cases test3 and test4 in t1A as well as the test1 case in t1C are excluded
from the test.

� Secondly, the test for system t2 should run. The included suites are t2B and t2C. Included are also
test cases test4, test1 and test7 in suite t2A. Note that the test cases will be executed in the
specified order.

� Lastly, all suites for systems t3 are to be completely skipped and this should be explicitly noted in
the log files.

It is possible for the user to provide a test specification that includes (for Common Test) unrecognizable
terms. If this is desired, the -allow user terms flag should be used when starting tests with run test.
This forces Common Test to ignore unrecognizable terms. Note that in this mode, Common Test is not
able to check the specification for errors as efficiently as if the scanner runs in default mode. If
ct:run test/1 is used for starting the tests, the relaxed scanner mode is enabled by means of the tuple:
fallow user terms,trueg

1.6.9 Log files

As the execution of the test suites go on, events are logged in four different ways:

� Text to the operator’s console.

� Suite related information is sent to the major log file.

� Case related information is sent to the minor log file.

� The HTML overview log file gets updated with test results.

� A link to all runs executed from a certain directory is written in the log named “all runs.html” and
direct links to all tests (the latest results) are written to the top level “index.html”.

Typically the operator, who may run hundreds or thousands of test cases, doesn’t want to fill the screen
with details about/from the specific test cases. By default, the operator will only see:

� A confirmation that the test has started and information about how many test cases will be
executed totally.
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� A small note about each failed test case.

� A summary of all the run test cases.

� A confirmation that the test run is complete.

� Some special information like error reports and progress reports, printouts written with
erlang:display/1 or io:format/3 specifically addressed to somewhere other than standard io.

This is enough for the operator to know, and if he wants to dig in deeper into a specific test case result,
he can do so by following the links in the HTML presentation to take a look in the major or minor log
files. The “all runs.html” page is a practical starting point usually. It’s located in logdir and contains a
link to each test run including a quick overview (date and time, node name, number of tests, test names
and test result totals).

An “index.html” page is written for each test run (i.e. stored in the “ct run” directory tagged with node
name, date and time). This file gives a short overview of all individual tests performed in the same test
run. The test names follow this convention:

� TopLevelDir.TestDir (all suites in TestDir executed)

� TopLevelDir.TestDir:suites (specific suites were executed)

� TopLevelDir.TestDir.Suite (all cases in Suite executed)

� TopLevelDir.TestDir.Suite:cases (specific test cases were executed)

� TopLevelDir.TestDir.Suite.Case (only Case was executed)

On the test run index page there is a link to the Common Test Framework log file in which information
about imported configuration data and general test progress is written. This log file is useful to get
snapshot information about the test run during execution. It can also be very helpful when analyzing
test results or debugging test suites.

On the test run index page it is noted if a test has missing suites (i.e. suites that Common Test has failed
to compile). Names of the missing suites can be found in the Common Test Framework log file.

A detailed report of the test run is stored in the major logfile (textual log file). This includes test suite
and test case names, execution time, the exact reason for failure etc. There is an HTML log file that
corresponds to this textual file. The HTML file is a summary which gives a better overview of the test
run. It also has links to each individual test case log file for quick viewing with an HTML browser.

The minor log file contain full details of every single test case, each one in a separate file. This way the
files should be easy to compare with previous test runs, even if the set of test cases change.

Which information goes where is user configurable via the test server controller. Three threshold values
determine what comes out on screen, and in the major or minor log files. See the OTP Test Server
manual for information. The contents that goes to the HTML log file is fixed however and cannot be
altered.

The log files are written continously during a test run and links are always created initially when a test
starts. This makes it possible to follow test progress simply by refreshing pages in the HTML browser.
Statistics totals are not presented until a test is complete however.
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1.6.10 HTML Style Sheets

Common Test includes the optional feature to use HTML style sheets (CSS) for customizing user
printouts. The functions in ct that print to a test case HTML log file (log/3 and pal/3) accept
Category as first argument. With this argument it’s possible to specify a category that can be mapped
to a selector in a CSS definition. This is useful especially for coloring text differently depending on the
type of (or reason for) the printout. Say you want one color for test system configuration information, a
different one for test system state information and finally one for errors detected by the test case
functions. The corresponding style sheet may look like this:

<style>
div.ct internal f background:lightgrey; color:black g
div.default f background:lightgreen; color:black g
div.sys config f background:blue; color:white g
div.sys state f background:yellow; color:black g
div.error f background:red; color:white g

</style>

To install the CSS file (Common Test inlines the definition in the HTML code), the name may be
provided when executing run test. Example:

$ run test -dir $TEST/prog -stylesheet $TEST/styles/test categories.css

Categories in a CSS file installed with the -stylesheet flag are on a global test level in the sense that
they can be used in any suite which is part of the test run.

It is also possible to install style sheets on a per suite and per test case basis. Example:

-module(my SUITE).
...
suite() -> [..., fstylesheet,"suite categories.css"g, ...].
...
my testcase( ) ->

...
ct:log(sys config, "Test node version: ~p", [VersionInfo]),
...
ct:log(sys state, "Connections: ~p", [ConnectionInfo]),
...
ct:pal(error, "Error ~p detected! Info: ~p", [SomeFault,ErrorInfo]),
ct:fail(SomeFault).

If the style sheet is installed as in this example, the categories are private to the suite in question. They
can be used by all test cases in the suite, but can not be used by other suites. A suite private style sheet,
if specified, will be used in favour of a global style sheet (one specified with the -stylesheet flag). A
stylesheet tuple (as returned by suite/0 above) can also be returned from a test case info function. In
this case the categories specified in the style sheet can only be used in that particular test case. A test
case private style sheet is used in favour of a suite or global level style sheet.

In a tuple fstylesheet,CSSFileg, if CSSFile is specified with a path, e.g.
"$TEST/styles/categories.css", this full name will be used to locate the file. If only the file name is
specified however, e.g. “categories.css”, then the CSS file is assumed to be located in the data directory,
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data dir, of the suite. The latter usage is recommended since it is portable compared to hard coding
path names in the suite!

The Category argument in the example above may have the value (atom) sys config (white on blue),
sys state (black on yellow) or error (white on red).

If the Category argument is not specified, Common Test will use the CSS selector div.default for the
printout. For this reason a user supplied style sheet must include this selector. Also the selector
div.ct internal must be included. Hence a minimal user style sheet should look like this (which is
also the default style sheet Common Test uses if no user CSS file is provided):

<style>
div.ct internal f background:lightgrey; color:black g
div.default f background:lightgreen; color:black g
</style>

1.6.11 Repeating tests

You can order Common Test to repeat the tests you specify. You can choose to repeat tests a certain
number of times, repeat tests for a specific period of time, or repeat tests until a particular stop time is
reached. If repetition is controlled by means of time, it is also possible to specify what action Common
Test should take upon timeout. Either Common Test performs all tests in the current run before
stopping, or it stops as soon as the current test job is finished. Repetition can be activated by means of
run test start flags, or tuples in the ct:run:test/1 option list argument. The flags (options in
parenthesis) are:

� -repeat N (frepeat,Ng), where N is a positive integer.

� -duration DurTime (fduration,DurTimeg), where DurTime is the duration, see below.

� -until StopTime (funtil,StopTimeg), where StopTime is finish time, see below.

� -force stop (fforce stop,trueg)

The duration time, DurTime, is specified as HHMMSS. Example: -duration 012030 or
fduration,"012030"g, means the tests will be executed and (if time allows) repeated, until timeout
occurs after 1 h, 20 min and 30 secs. StopTime can be specified as HHMMSS and is then interpreted as a
time today (or possibly tomorrow). StopTime can also be specified as YYMoMoDDHHMMSS. Example:
-until 071001120000 or funtil,"071001120000"g, which means the tests will be executed and (if
time allows) repeated, until 12 o’clock on the 1st of Oct 2007.

When timeout occurs, Common Test will never abort the test run immediately, since this might leave
the system under test in an undefined, and possibly bad, state. Instead Common Test will finish the
current test job, or the complete test run, before stopping. The latter is the default behaviour. The
force stop flag/option tells Common Test to stop as soon as the current test job is finished. Note that
since Common Test always finishes off the current test job or test session, the time specified with
duration or until is never definitive!

Log files from every single repeated test run is saved in normal Common Test fashion (see above).
Common Test may later support an optional feature to only store the last (and possibly the first) set of
logs of repeated test runs, but for now the user must be careful not to run out of disk space if tests are
repeated during long periods of time.

Note that for each test run that is part of a repeated session, information about the particular test run is
printed in the Common Test Framework Log. There you can read the repetition number, remaining
time, etc.

Example 1:
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$ run test -dir $TEST ROOT/to1 $TEST ROOT/to2 -duration 001000 -force stop

Here the suites in test directory to1, followed by the suites in to2, will be executed in one test run. A
timeout event will occur after 10 minutes. As long as there is time left, Common Test will repeat the
test run (i.e. starting over with the to1 test). When the timeout occurs, Common Test will stop as soon
as the current job is finished (because of the force stop flag). As a result, the specified test run might
be aborted after the to1 test and before the to2 test.

Example 2:

$ date
Fri Sep 28 15:00:00 MEST 2007

$ run test -dir $TEST ROOT/to1 $TEST ROOT/to2 -until 160000

Here the same test run as in the example above will be executed (and possibly repeated). In this
example, however, the timeout will occur after 1 hour and when that happens, Common Test will finish
the entire test run before stopping (i.e. the to1 and to2 test will always both be executed in the same
test run).

Example 3:

$ run test -dir $TEST ROOT/to1 $TEST ROOT/to2 -repeat 5

Here the test run, including both the to1 and the to2 test, will be repeated 5 times.

1.6.12 Silent Connections

The protocol handling processes in Common Test, implemented by ct telnet, ct ftp etc, do verbose
printing to the test case logs. This can be switched off by means of the -silent connections flag:

run test -silent connections [conn types]

where conn types specifies telnet, ftp, rpc and/or snmp.

Example:

run test ... -silent connections telnet ftp

switches off logging for telnet and ftp connections.

run test ... -silent connections
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switches off logging for all connection types.

Basic and important information such as opening and closing a connection, fatal communication error
and reconnection attempts will always be printed even if logging has been suppressed for the connection
type in question. However, operations such as sending and receiving data may be performed silently.

It is possible to also specify silent connections in a test suite. This is accomplished by returning a
tuple, fsilent connections,ConnTypesg, in the suite/0 or test case info list. If ConnTypes is a list of
atoms (telnet, ftp, rpc and/or snmp), output for any corresponding connections will be suppressed.
Full logging is per default enabled for any connection of type not specified in ConnTypes. Hence, if
ConnTypes is the empty list, logging is enabled for all connections.

The silent connections setting returned from a test case info function overrides, for the test case in
question, any setting made with suite/0 (which is the setting used for all cases in the suite). Example:

-module(my SUITE).
...
suite() -> [..., fsilent connections,[telnet,ftp]g, ...].
...
my testcase1() ->
[fsilent connections,[ftp]g].
my testcase1( ) ->
...
my testcase2( ) ->
...

In this example, suite/0 tells Common Test to suppress printouts from telnet and ftp connections.
This is valid for all test cases. However, my testcase1/0 specifies that for this test case, only ftp should
be silent. The result is that my testcase1 will get telnet info (if any) printed in the log, but not ftp info.
my testcase2 will get no info from either connection printed.

The -silent connections tag (or silent connections tagged tuple in the call to ct:run test/1)
overrides any settings in the test suite.

Note that in the current Common Test version, the silent connections feature only works for telnet
connections. Support for other connection types will be added in future Common Test versions.

1.7 Config Files

1.7.1 General

The Common Test framework uses configuration files to describe data related to a test and/or an SUT
(System Under Test). The configuration data makes it possible to change properties without changing
the test program itself. Configuration data can for example be:

� Addresses to the test plant or other instruments

� Filenames for files needed by the test

� Program names for programs that shall be run by the test

� Any other variable that is needed by the test
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1.7.2 Syntax

A configuration file can contain any number of elements of the type:

fKey,Valueg.

where

Key = atom()
Value = term() | [fKey,Valueg]

1.7.3 Requiring and reading configuration data

In a test suite, one must require that a configuration variable exists before attempting to read the
associated value in a test case.

require is an assert statement that can be part of the test suite info function [page 8] or test case info
function [page 6]. If the required variable is not available, the test is skipped (unless a default value has
been specified, see the test case info function [page 6] chapter for details). There is also a function
ct:require/[1,2] which can be called from a test case in order to check if a specific variable is
available. The return value from this function must be checked explicitly and appropriate action be
taken depending on the result (e.g. to skip the test case if the variable in question doesn’t exist).

A require statement in the test suite info- or test case info-list should look like this:
frequire,Requiredg or frequire,Name,Requiredg. The arguments Name and Required are the same
as the arguments to ct:require/[1,2] which are described in the reference manual for ct [page 64].
Name becomes an alias for the configuration variable Required, and can be used as reference to the
configuration data value. The configuration variable may be associated with an arbitrary number of alias
names, but each name must be unique within the same test suite. There are two main uses for alias
names:

� They may be introduced to identify connections (see below).

� They may used to help adapt configuration data to a test suite (or test case) and improve
readability.

To read the value of a config variable, use the function get config/[1,2,3] which is also described in
the reference manual for ct [page 64].

Example:

suite() ->
[frequire, domain, ’CONN SPEC DNS SUFFIX’g].

...

testcase(Config) ->
Domain = ct:get config(domain),
...
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1.7.4 Using configuration variables defined in multiple files

If a configuration variable is defined in multiple files and you want to access all possible values, you may
use the ct:get config/3 function and specify all in the options list. The values will then be returned
in a list and the order of the elements corresponds to the order that the config files were specified at
startup. Please see the ct [page 64] reference manual for details.

1.7.5 Encrypted configuration files

It is possible to encrypt configuration files containing sensitive data if these files must be stored in open
and shared directories.

Call ct:encrypt config file/[2,3] to have Common Test encrypt a specified file using the DES3
function in the OTP crypto application. The encrypted file can then be used as a regular configuration
file, in combination with other encrypted files or normal text files. The key for decrypting the
configuration file must be provided when running the test, however. This can be done by means of the
decrypt key or decrypt file flag/option, or a key file in a predefined location.

Common Test also provides decryption functions, ct:decrypt config file/[2,3], for recreating the
original text files.

Please see the ct [page 64] reference manual for more information.

1.7.6 Opening connections by using configuration data

There are two different methods for opening a connection by means of the support functions in e.g.
ct ssh, ct ftp, and ct telnet:

� Using a configuration target name (an alias) as reference.

� Using the configuration variable as reference.

When a target name is used for referencing the configuration data (that specifies the connection to be
opened), the same name may be used as connection identity in all subsequent calls related to the
connection (also for closing it). It’s only possible to have one open connection per target name. If
attempting to open a new connection using a name already associated with an open connection,
Common Test will return the already existing handle so that the previously opened connection will be
used. This is a practical feature since it makes it possible to call the function for opening a particular
connection whenever useful. An action like this will not necessarily open any new connections unless
it’s required (which could be the case if e.g. the previous connection has been closed unexpectedly by
the server). Another benefit of using named connections is that it’s not necessary to pass handle
references around in the suite for these connections.

When a configuration variable name is used as reference to the data specifying the connection, the
handle returned as a result of opening the connection must be used in all subsequent calls (also for
closing the connection). Repeated calls to the open function with the same variable name as reference
will result in multiple connections being opened. This can be useful e.g. if a test case needs to open
multiple connections to the same server on the target node (using the same configuration data for each
connection).
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1.7.7 Examples

A config file for using the FTP client to access files on a remote host could look like this:

fftp host, [fftp,"targethost"g,
fusername,"tester"g,
fpassword,"letmein"g]g.

flm directory, "/test/loadmodules"g.

Example of how to assert that the configuration data is available and use it for an FTP session:

init per testcase(ftptest, Config) ->
fok, g = ct ftp:open(ftp),
Config.

end per testcase(ftptest, Config) ->
ct ftp:close(ftp).

ftptest() ->
[frequire,ftp,ftp hostg,
frequire,lm directoryg].

ftptest(Config) ->
Remote = filename:join(ct:get config(lm directory), "loadmodX"),
Local = filename:join(?config(priv dir,Config), "loadmodule"),
ok = ct ftp:recv(ftp, Remote, Local),
...

An example of how the above functions could be rewritten if necessary to open multiple connections to
the FTP server:

init per testcase(ftptest, Config) ->
fok,Handle1g = ct ftp:open(ftp host),
fok,Handle2g = ct ftp:open(ftp host),
[fftp handles,[Handle1,Handle2]g | Config].

end per testcase(ftptest, Config) ->
lists:foreach(fun(Handle) -> ct ftp:close(Handle) end,

?config(ftp handles,Config)).

ftptest() ->
[frequire,ftp hostg,
frequire,lm directoryg].

ftptest(Config) ->
Remote = filename:join(ct:get config(lm directory), "loadmodX"),
Local = filename:join(?config(priv dir,Config), "loadmodule"),
[Handle | MoreHandles] = ?config(ftp handles,Config),
ok = ct ftp:recv(Handle, Remote, Local),
...
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1.8 Code Coverage Analysis

1.8.1 General

Although Common Test was created primarly for the purpose of black box testing, nothing prevents it
from working perfectly as a white box testing tool as well. This is especially true when the application
to test is written in Erlang. Then the test ports are easily realized by means of Erlang function calls.

When white box testing an Erlang application, it is useful to be able to measure the code coverage of
the test. Common Test provides simple access to the OTP Cover tool for this purpose. Common Test
handles all necessary communication with the Cover tool (starting, compiling, analysing, etc). All the
Common Test user needs to do is to specify the extent of the code coverage analysis.

1.8.2 Usage

To specify what modules should be included in the code coverage test, you provide a cover specification
file. Using this file you can point out specific modules or specify directories that contain modules which
should all be included in the analysis. You can also, in the same fashion, specify modules that should be
excluded from the analysis.

If you are testing a distributed Erlang application, it is likely that code you want included in the code
coverage analysis gets executed on an Erlang node other than the one Common Test is running on. If
this is the case you need to specify these other nodes in the cover specification file or add them
dynamically to the code coverage set of nodes. See the ct cover page in the reference manual for
details on the latter.

In the cover specification file you can also specify your required level of the code coverage analysis;
details or overview. In detailed mode, you get a coverage overview page, showing you per module
and total coverage percentages, as well as one HTML file printed for each module included in the
analysis that shows exactly what parts of the code have been executed during the test. In overview
mode, only the code coverage overview page gets printed.

Note: Currently, for Common Test to be able to print code coverage HTML files for the modules
included in the analysis, the source code files of these modules must be located in the same directory as
the corresponding .beam files. This is a limitation that will be removed later.

You can choose to export and import code coverage data between tests. If you specify the name of an
export file in the cover specification file, Common Test will export collected coverage data to this file at
the end of the test. You may similarly specify that previously exported data should be imported and
included in the analysis for a test (you can specify multiple import files). This way it is possible to
analyse total code coverage without necessarily running all tests at once. Note that even if you run
separate tests in one test run, code coverage data will not be passed on from one test to another unless
you specify an export file for Common Test to use for this purpose.

To activate the code coverage support, you simply specify the name of the cover specification file as you
start Common Test. This you do either by using the -cover flag with run test. Example:

$ run test -dir $TESTOBJS/db -cover $TESTOBJS/db/config/db.coverspec

You may also pass the cover specification file name in a call to ct:run test/1, by adding a
fcover,CoverSpecg tuple to the Opts argument. Also, you can of course enable code coverage in your
test specifications (read more in the chapter about using test specifications [page 20]).
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1.8.3 The cover specification file

These are the terms allowed in a cover specification file:

%% List of Nodes on which cover will be active during test.
%% Nodes = [atom()]
fnodes, Nodesg.

%% Files with previously exported cover data to include in analysis.
%% CoverDataFiles = [string()]
fimport, CoverDataFilesg.

%% Cover data file to export from this session.
%% CoverDataFile = string()
fexport, CoverDataFileg.

%% Cover analysis level.
%% Level = details | overview
flevel, Levelg.

%% Directories to include in cover.
%% Dirs = [string()]
fincl dirs, Dirsg.

%% Directories, including subdirectories, to include.
fincl dirs r, Dirsg.

%% Specific modules to include in cover.
%% Mods = [atom()]
fincl mods, Modsg.

%% Directories to exclude in cover.
fexcl dirs, Dirsg.

%% Directories, including subdirectories, to exclude.
fexcl dirs r, Dirsg.

%% Specific modules to exclude in cover.
fexcl mods, Modsg.

The incl dirs r and excl dirs r terms tell Common Test to search the given directories recursively
and include or exclude any module found during the search. The incl dirs and excl dirs terms
result in a non-recursive search for modules (i.e. only modules found in the given directories are
included or excluded).

Note: Directories containing Erlang modules that are to be included in a code coverage test must exist
in the code server path, or the cover tool will fail to recompile the modules. (It is not sufficient to
specify these directories in the cover specification file for Common Test).
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1.8.4 Logging

To view the result of a code coverage test, follow the “Coverage log” link on the test suite results page.
This takes you to the code coverage overview page. If you have successfully performed a detailed
coverage analysis, you find links to each individual module coverage page here.

1.9 Using Common Test for Large Scale Testing

1.9.1 General

Large scale automated testing requires running multiple independent test sessions in parallel. This is
accomplished by running a number of Common Test nodes on one or more hosts, testing different
target systems. Configuring, starting and controlling the test nodes independently can be a cumbersome
operation. To aid this kind of automated large scale testing, CT offers a master test node component,
CT Master, that handles central configuration and control in a system of distributed CT nodes.

The CT Master server runs on one dedicated Erlang node and uses distributed Erlang to communicate
with any number of CT test nodes, each hosting a regular CT server. Test specifications are used as
input to specify what to test on which test nodes, using what configuration.

The CT Master server writes progress information to HTML log files similarly to the regular CT server.
The logs contain test statistics and links to the log files written by each independent CT server.

The CT master API is exported by the ct master module.

1.9.2 Usage

CT Master requires all test nodes to be on the same network and share a common file system. As of this
date, CT Master can not start test nodes automatically. The nodes must have been started in advance
for CT Master to be able to start test sessions on them.

Tests are started by calling:

ct master:run(TestSpecs) or ct master:run(TestSpecs, InclNodes, ExclNodes)

TestSpecs is either the name of a test specification file (string) or a list of test specifications. In case of a
list, the specifications will be handled (and the corresponding tests executed) in sequence. An element
in a TestSpecs list can also be list of test specifications. The specifications in such a list will be merged
into one combined specification prior to test execution. For example:

ct master:run(["ts1","ts2",["ts3","ts4"]])

means first the tests specified by “ts1” will run, then the tests specified by “ts2” and finally the tests
specified by both “ts3” and “ts4”.

The InclNodes argument to run/3 is a list of node names. The run/3 function runs the tests in
TestSpecs just like run/1 but will also take any test in TestSpecs that’s not explicitly tagged with a
particular node name and execute it on the nodes listed in InclNodes. By using run/3 this way it is
possible to use any test specification, with or without node information, in a large scale test
environment! ExclNodes is a list of nodes that should be excluded from the test. I.e. tests that have
been specified in the test specification to run on a particular node will not be performed if that node is
at runtime listed in ExclNodes.

If CT Master fails initially to connect to any of the test nodes specified in a test specification or in the
InclNodes list, the operator will be prompted with the option to either start over again (after manually
checking the status of the node(s) in question), to run without the missing nodes, or to abort the
operation.
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When tests start, CT Master prints information to console about the nodes that are involved. CT
Master also reports when tests finish, successfully or unsuccessfully. If connection is lost to a node, the
test on that node is considered finished. CT Master will not attempt to reestablish contact with the
failing node. At any time to get the current status of the test nodes, call the function:

ct master:progress()

To stop one or more tests, use:

ct master:abort() (stop all) or ct master:abort(Nodes)

For detailed information about the ct master API, please see the manual page for this module.

1.9.3 Test Specifications

The test specifications used as input to CT Master are fully compatible with the specifications used as
input to the regular CT server. The syntax is described in the Running Test Suites [page 20] chapter.

All test specification terms can have a NodeRefs element. This element specifies which node or nodes a
configuration operation or a test is to be executed on. NodeRefs is defined as:

NodeRefs = all nodes | [NodeRef] | NodeRef

where

NodeRef = NodeAlias | node() | master

A NodeAlias (atom()) is used in a test specification as a reference to a node name (so the actual node
name only needs to be declared once). The alias is declared with a node term:

fnode, NodeAlias, NodeNameg

If NodeRefs has the value all nodes, the operation or test will be performed on all given test nodes.
(Declaring a term without a NodeRefs element actually has the same effect). If NodeRefs has the value
master, the operation is only performed on the CT Master node (namely set the log directory or install
an event handler).

Consider the example in the Running Test Suites [page 20] chapter, now extended with node
information and intended to be executed by the CT Master:

fnode, node1, ct node@host xg.
fnode, node2, ct node@host yg.

flogdir, master, "/home/test/master logs"g.
flogdir, "/home/test/logs"g.

fconfig, node1, "/home/test/t1/cfg/config.cfg"g.
fconfig, node2, "/home/test/t2/cfg/config.cfg"g.
fconfig, "/home/test/t3/cfg/config.cfg"g.

falias, t1, "/home/test/t1"g.
falias, t2, "/home/test/t2"g.
falias, t3, "/home/test/t3"g.

fsuites, node1, t1, allg.
fskip suites, node1, t1, [t1B SUITE,t1D SUITE], "Not implemented"g.
fskip cases, node1, t1, t1A SUITE, [test3,test4], "Irrelevant"g.
fskip cases, node1, t1, t1C SUITE, [test1], "Ignore"g.

fsuites, node2, t2, [t2B SUITE,t2C SUITE]g.
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fcases, node2, t2, t2A SUITE, [test4,test1,test7]g.

fskip suites, t3, all, "Not implemented"g.

This example specfies the same tests as the original example. But now if started with a call to
ct master:run(TestSpecName), the t1 test will be executed on node ct node@host x (node1), the t2
test on ct node@host y (node2) and the t3 test on both node1 and node2. The t1 config file will only
be read on node1 and the t2 config file only on node2, while the t3 config file will be read on both
node1 and node2. Both test nodes will write log files to the same directory. (The CT Master node will
however use a different log directory than the test nodes).

If the test session is instead started with a call to ct master:run(TestSpecName, [ct node@host z],
[ct node@host x]), the result is that the t1 test does not run on ct node@host x (or any other node)
while the t3 test runs on ct node@host y and ct node@host z.

A nice feature is that a test specification that includes node information can still be used as input to the
regular Common Test server (as described in the Running Test Suites [page 20] chapter). The result is
that any test specified to run on a node with the same name as the Common Test node in question
(typically ct@somehost if started with the run test script), will be performed. Tests without explicit
node association will always be performed too of course!

Note:
It is recommended that absolute paths are used for log directories, config files and test directory
aliases in the test specifications so that current working directory settings are not important.

1.10 Event Handling

1.10.1 General

It is possible for the operator of a Common Test system to receive event notifications continously
during a test session execution. It is reported e.g. when a test case starts and stops, what the current
count of succeeded, failed and skipped cases is, etc. This information can be used for different purposes
such as logging progress and results on other format than HTML, saving statistics to a database for
report generation and test system supervision.

Common Test has a framework for event handling which is based on the OTP event manager concept
and gen event behaviour. When the Common Test server starts, it spawns an event manager. During
test execution the manager gets a notification from the server every time something of potential interest
happens. Any event handler plugged into the event manager can match on event notifications, take
some action or pass the information on. Event handlers are Erlang modules implemented by the
Common Test user according to the gen event behaviour (see the OTP User’s Guide and Reference
Manual for more information).

As already described, a Common Test server always starts an event manager. The server also plugs in a
default event handler which has as its only purpose to relay notifications to a globally registered CT
Master event manager (if a CT Master server is actually running in the system). The CT Master also
spawns an event manager at startup. Event handlers plugged into this manager will receive the events
from all the test nodes as well as information from the CT Master server itself.
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1.10.2 Usage

Event handlers may be plugged in by means of test specification [page 20] terms:

fevent handler, EventHandlersg, or

fevent handler, EventHandlers, InitArgsg, or

fevent handler, NodeRefs, EventHandlersg, or

fevent handler, NodeRefs, EventHandlers, InitArgsg

EventHandlers is a list of modules (each having gen event behaviour). An event handler module must
be precompiled and its location must be specified in the Erlang runtime system code path. Before a test
session starts, the init function of each plugged in event handler is called (with the InitArgs list as
argument or [] if no start arguments are given).

To plug a handler into the CT Master event manager, specify master as the node in NodeRefs.

For an event handler to be able to match on events, the module must include the header file
ct event.hrl. An event is a record with the following definition:

#eventfname, node, datag

name is the label (type) of the event. node is the name of the node the event has originated from (only
relevant for CT Master event handlers). data is data specific for the particular event.

Events:

%% Indication that the test run is starting.
#event.name = test start
#event.data = fStartTime,LogDirg
StartTime = fdate(),time()g
LogDir = string()

%% Initial information about the test run; the number of
%% tests, suites and test cases. Note that if a test case
%% group with a repeat property exists, the total number
%% of test cases can not be calculated (unknown).
#event.name = start info
#event.data = fTests,Suites,Casesg
Tests = Suites = integer()
Cases = integer() | unknown

%% Indication that the test run is finished.
#event.name = test done
#event.data = EndTime
EndTime = fdate(),time()g

%% Common Test is compiling files in specified directory.
#event.name = start make
#event.data = Dir
Dir = string()

%% Common Test is finished with compilation.
#event.name = finished make
#event.data = Dir
Dir = string()
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%% A test case is starting. In case of a test case group
%% configuration function, the group name and properties
%% are also given.
#event.name = tc start
#event.data = fSuite,CaseOrGroupg
Suite = atom()
CaseOrGroup = Case | fConf,GroupName,GroupPropertiesg
Case = atom()
Conf = init per group | end per group
GroupName = atom()
GroupProperties = list()

%% A test case is finished and this event reports the
%% result. In case of a test case group configuration
%% function, the group name and properties are also given.
#event.name = tc done
#event.data = fSuite,CaseOrGroup,Resultg
Suite = atom()
CaseOrGroup = Case | fConf,GroupName,GroupPropertiesg
Case = atom()
Conf = init per group | end per group
GroupName = atom()
GroupProperties = list()
Result = ok | fskipped,Reasong | ffailed,Reasong
Reason = term()

%% A test case has been skipped by the user.
#event.name = tc user skip
#event.data = fSuite,Case,Commentg
Suite = atom()
Case = atom()
Comment = string()

%% A test case has been automatically skipped by
%% Common Test (e.g. because of a failing configuration
%% function or an unsuccessful require operation).
#event.name = tc auto skip
#event.data = fSuite,Case,Commentg
Suite = atom()
Case = atom()
Comment = string()

%% A statistics event with the current count of
%% successful, skipped and failed test cases so far.
%% This event gets sent after the end of each test case.
#event.name = test stats
#event.data = fOk,Failed,Skippedg
Ok = Failed = Skipped = integer()

%% Indication that the logging process of Common Test
%% has been started successfully and is ready for IO.
#event.name = start logging
#event.data = CtRunDir
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CtRunDir = string()

%% Indication that the logging process of Common Test
%% has been shut down at the end of the test run.
#event.name = stop logging
#event.data = []

%% Internal event used by the Common Test Master
%% process to synchronize particular file operations.
#event.name = start write file
#event.data = FullNameFile
FullNameFile = string()

%% Internal event used by the Common Test Master
%% process to synchronize particular file operations.
#event.name = finished write file
#event.data = FullNameFile
FullNameFile = string()

The events are also documented in ct event.erl. This module may serve as an example of what an
event handler for the CT event manager can look like.

Besides the event handler test specification terms, it is also possible to install event handlers by means
of the run test flag -event handler, e.g:

$ run test -dir my testobj -event handler my evh1 my evh2

Note that it is not posible to specify start arguments to the event handlers when using the run test
script. You may however pass along start arguments if you use the ct:run test/1 function. An
event handler tuple in the argument Opts has the following definition (see also ct:run test/1 in the
reference manual):

fevent handler,EventHandlersg

EventHandlers = EH | [EH]
EH = atom() | fatom(),InitArgsg | f[atom()],InitArgsg
InitArgs = [term()]

Example:

1> ct:run test([fdir,"my testobj"g,fevent handler,[my evh1,fmy evh2,[node()]g]g]).

This will install two event handlers for the my testobj test. Event handler my evh1 is started with [] as
argument to the init function. Event handler my evh2 is started with the name of the current node in
the init argument list.
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1.11 Dependencies between Test Cases and Suites

1.11.1 General

When creating test suites, it is strongly recommended to not create dependencies between test cases, i.e.
letting test cases depend on the result of previous test cases. There are various reasons for this, for
example:

� It makes it impossible to run test cases individually.

� It makes it impossible to run test cases in different order.

� It makes debugging very difficult (since a fault could be the result of a problem in a different test
case than the one failing).

� There exists no good and explicit ways to declare dependencies, so it may be very difficult to see
and understand these in test suite code and in test logs.

� Extending, restructuring and maintaining test suites with test case dependencies is difficult.

There are often sufficient means to work around the need for test case dependencies. Generally, the
problem is related to the state of the system under test (SUT). The action of one test case may alter the
state of the system and for some other test case to run properly, the new state must be known.

Instead of passing data between test cases, it is recommended that the test cases read the state from the
SUT and perform assertions (i.e. let the test case run if the state is as expected, otherwise reset or fail)
and/or use the state to set variables necessary for the test case to execute properly. Common actions can
often be implemented as library functions for test cases to call to set the SUT in a required state. (Such
common actions may of course also be separately tested if necessary, to ensure they are working as
expected). It is sometimes also possible, but not always desirable, to group tests together in one test
case, i.e. let a test case perform a “scenario” test (a test that consists of subtests).

Consider for example a server application under test. The following functionality is to be tested:

� Starting the server.

� Configuring the server.

� Connecting a client to the server.

� Disconnecting a client from the server.

� Stopping the server.

There are obvious dependencies between the listed functions. We can’t configure the server if it hasn’t
first been started, we can’t connect a client until the server has been properly configured, etc. If we
want to have one test case for each of the functions, we might be tempted to try to always run the test
cases in the stated order and carry possible data (identities, handles, etc) between the cases and
therefore introduce dependencies between them. To avoid this we could consider starting and stopping
the server for every test. We would implement the start and stop action as common functions that may
be called from init per testcase and end per testcase. (We would of course test the start and stop
functionality separately). The configuration could perhaps also be implemented as a common function,
maybe grouped with the start function. Finally the testing of connecting and disconnecting a client may
be grouped into one test case. The resulting suite would look something like this:

-module(my server SUITE).
-compile(export all).
-include lib("ct.hrl").

%%% init and end functions...
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suite() -> [frequire,my server cfgg].

init per testcase(start and stop, Config) ->
Config;

init per testcase(config, Config) ->
[fserver pid,start server()g | Config];

init per testcase( , Config) ->
ServerPid = start server(),
configure server(),
[fserver pid,ServerPidg | Config].

end per testcase(start and stop, ) ->
ok;

end per testcase( , ) ->
ServerPid = ?config(server pid),
stop server(ServerPid).

%%% test cases...

all() -> [start and stop, config, connect and disconnect].

%% test that starting and stopping works
start and stop( ) ->

ServerPid = start server(),
stop server(ServerPid).

%% configuration test
config(Config) ->

ServerPid = ?config(server pid, Config),
configure server(ServerPid).

%% test connecting and disconnecting client
connect and disconnect(Config) ->

ServerPid = ?config(server pid, Config),
fok,SessionIdg = my server:connect(ServerPid),
ok = my server:disconnect(ServerPid, SessionId).

%%% common functions...

start server() ->
fok,ServerPidg = my server:start(),
ServerPid.

stop server(ServerPid) ->
ok = my server:stop(),
ok.

configure server(ServerPid) ->
ServerCfgData = ct:get config(my server cfg),
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ok = my server:configure(ServerPid, ServerCfgData),
ok.

1.11.2 Saving configuration data

There might be situations where it is impossible, or infeasible at least, to implement independent test
cases. Maybe it is simply not possible to read the SUT state. Maybe resetting the SUT is impossible and
it takes much too long to restart the system. In situations where test case dependency is necessary, CT
offers a structured way to carry data from one test case to the next. The same mechanism may also be
used to carry data from one test suite to the next.

The mechanism for passing data is called save config. The idea is that one test case (or suite) may save
the current value of Config - or any list of key-value tuples - so that it can be read by the next executing
test case (or test suite). The configuration data is not saved permanently but can only be passed from
one case (or suite) to the next.

To save Config data, return the tuple:

fsave config,ConfigListg

from end per testcase or from the main test case function. To read data saved by a previous test case,
use the config macro with a saved config key:

fSaver,ConfigListg = ?config(saved config, Config)

Saver (atom()) is the name of the previous test case (where the data was saved). The config macro
may be used to extract particular data also from the recalled ConfigList. It is strongly recommended
that Saver is always matched to the expected name of the saving test case. This way problems due to
restructuring of the test suite may be avoided. Also it makes the dependency more explicit and the test
suite easier to read and maintain.

To pass data from one test suite to another, the same mechanism is used. The data should be saved by
the end per suite function and read by init per suite in the suite that follows. When passing data
between suites, Saver carries the name of the test suite.

Example:

-module(server b SUITE).
-compile(export all).
-include lib("ct.hrl").

%%% init and end functions...

init per suite(Config) ->
%% read config saved by previous test suite
fserver a SUITE,OldConfigg = ?config(saved config, Config),
%% extract server identity (comes from server a SUITE)
ServerId = ?config(server id, OldConfig),
SessionId = connect to server(ServerId),
[fids,fServerId,SessionIdgg | Config].

end per suite(Config) ->
%% save config for server c SUITE (session id and server id)
fsave config,Configg

%%% test cases...
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all() -> [allocate, deallocate].

allocate(Config) ->
fServerId,SessionIdg = ?config(ids, Config),
fok,Handleg = allocate resource(ServerId, SessionId),
%% save handle for deallocation test
NewConfig = [fhandle,Handleg],
fsave config,NewConfigg.

deallocate(Config) ->
fServerId,SessionIdg = ?config(ids, Config),
fallocate,OldConfigg = ?config(saved config, Config),
Handle = ?config(handle, OldConfig),
ok = deallocate resource(ServerId, SessionId, Handle).

It is also possible to save Config data from a test case that is to be skipped. To accomplish this, return
the following tuple:

fskip and save,Reason,ConfigListg

The result will be that the test case is skipped with Reason printed to the log file (as described in
previous chapters), and ConfigList is saved for the next test case. ConfigList may be read by means
of ?config(saved config, Config), as described above. skip and save may also be returned from
init per suite, in which case the saved data can be read by init per suite in the suite that follows.

1.11.3 Sequences

It is possible that test cases depend on each other so that if one case fails, the following test(s) should
not be executed. Typically, if the save config facility is used and a test case that is expected to save
data crashes, the following case can not run. CT offers a way to declare such dependencies, called
sequences.

A sequence of test cases is defined as a test case group with a sequence property. Test case groups are
defined by means of the groups/0 function in the test suite (see the Test case groups [page 8] chapter
for details).

For example, if we would like to make sure that if allocate in server b SUITE (above) crashes,
deallocate is skipped, we may define a sequence like this:

groups() -> [falloc and dealloc, [sequence], [alloc,dealloc]g].

Let’s also assume the suite contains the test case get resource status, which is independent of the
other two cases, then the all function could look like this:

all() -> [fgroup,alloc and deallocg, get resource status].

If alloc succeeds, dealloc is also executed. If alloc fails however, dealloc is not executed but
marked as SKIPPED in the html log. get resource status will run no matter what happens to the
alloc and dealloc cases.

Test cases in a sequence will be executed in order until they have all succeeded or until one case fails. If
one fails, all following cases in the sequence are skipped. The cases in the sequence that have succeeded
up to that point are reported as successful in the log. An arbitrary number of sequences may be
specified. Example:
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groups() -> [fscenarioA, [sequence], [testA1, testA2]g,
fscenarioB, [sequence], [testB1, testB2, testB3]g].

all() -> [test1,
test2,
fgroup,scenarioAg,
test3,
fgroup,scenarioBg,
test4].

It is possible to have sub-groups in a sequence group. Such sub-groups can have any property, i.e. they
are not required to also be sequences. If you want the status of the sub-group to affect the sequence on
the level above, return freturn group result,Statusg from end per group/2, as described in the
Repeated groups [page 11] chapter. A failed sub-group (Status == failed) will cause the execution
of a sequence to fail in the same way a test case does.

1.12 Some thoughts about testing

1.12.1 Goals

It’s not possible to prove that a program is correct by testing. On the contrary, it has been formally
proven that it is impossible to prove programs in general by testing. Theoretical program proofs or plain
examination of code may be viable options for those that wish to certify that a program is correct. The
test server, as it is based on testing, cannot be used for certification. Its intended use is instead to (cost
effectively) find bugs. A successful test suite is one that reveals a bug. If a test suite results in Ok, then
we know very little that we didn’t know before.

1.12.2 What to test?

There are many kinds of test suites. Some concentrate on calling every function or command (in the
documented way) in a certain interface. Some other do the same, but uses all kinds of illegal
parameters, and verifies that the server stays alive and rejects the requests with reasonable error codes.
Some test suites simulate an application (typically consisting of a few modules of an application), some
try to do tricky requests in general, some test suites even test internal functions with help of special
loadmodules on target.

Another interesting category of test suites are the ones that check that fixed bugs don’t reoccur. When a
bugfix is introduced, a test case that checks for that specific bug should be written and submitted to the
affected test suite(s).

Aim for finding bugs. Write whatever test that has the highest probability of finding a bug, now or in
the future. Concentrate more on the critical parts. Bugs in critical subsystems are a lot more expensive
than others.

Aim for functionality testing rather than implementation details. Implementation details change quite
often, and the test suites should be long lived. Often implementation details differ on different
platforms and versions. If implementation details have to be tested, try to factor them out into separate
test cases. Later on these test cases may be rewritten, or just skipped.

Also, aim for testing everything once, no less, no more. It’s not effective having every test case fail just
because one function in the interface changed.
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Manual

Short Summaries

� Application common test [page 56] – A framework for automated testing of
arbitrary target nodes

� Application run test [page 62] – Shell script used for starting Common Test from
the Unix command line.

� Erlang Module ct [page 64] – Main user interface for the Common Test
framework.

� Erlang Module ct cover [page 74] – Common Test Framework code coverage
support module.

� Erlang Module ct ftp [page 75] – FTP client module (based on the FTP support of
the INETS application).

� Erlang Module ct master [page 78] – Distributed test execution control for
Common Test.

� Erlang Module ct rpc [page 81] – Common Test specific layer on Erlang/OTP rpc.

� Erlang Module ct snmp [page 84] – Common Test user interface module for the
OTP snmp application.

� Erlang Module ct ssh [page 90] – SSH/SFTP client module.

� Erlang Module ct telnet [page 104] – Common Test specific layer on top of telnet
client ct telnet client.erl.

� Erlang Module unix telnet [page 109] – Callback module for ct telnet for talking
telnet to a unix host.

common test

The following functions are exported:

� Module:all() -> TestCases | fskip,Reasong
[page 56] Returns the list of all test cases in the module.

� Module:groups() -> GroupDefs
[page 57] Returns a list of test case group definitions.

� Module:suite() -> [Info]
[page 57] Test suite info function (providing default data for the suite).
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� Module:init per suite(Config) -> NewConfig | fskip,Reasong |
fskip and save,Reason,SaveConfigg
[page 58] Test suite initialization.

� Module:end per suite(Config) -> void() | fsave config,SaveConfigg
[page 58] Test suite finalization.

� Module:init per group(GroupName, Config) -> NewConfig |
fskip,Reasong
[page 58] Test case group initialization.

� Module:end per group(GroupName, Config) -> void() |
freturn group result,Statusg
[page 59] Test case group finalization.

� Module:init per testcase(TestCase, Config) -> NewConfig |
fskip,Reasong
[page 59] Test case initialization.

� Module:end per testcase(TestCase, Config) -> void() |
fsave config,SaveConfigg
[page 60] Test case finalization.

� Module:testcase() -> [Info]
[page 60] Test case info function.

� Module:testcase(Config) -> void() | fskip,Reasong |
fcomment,Commentg | fsave config,SaveConfigg |
fskip and save,Reason,SaveConfigg | exit()
[page 60] A test case

run test

No functions are exported.

ct

The following functions are exported:

� abort current testcase(Reason) -> ok | ferror, no testcase runningg
[page 64] When calling this function, the currently executing test case will be
aborted.

� comment(Comment) -> void()
[page 64] Print the given Comment in the comment field of the table on the test
suite result page.

� decrypt config file(EncryptFileName, TargetFileName) -> ok | ferror,
Reasong
[page 65] This function decrypts EncryptFileName, previously generated with
encrypt config file/2/3.

� decrypt config file(EncryptFileName, TargetFileName, KeyOrFile) ->
ok | ferror, Reasong
[page 65] This function decrypts EncryptFileName, previously generated with
encrypt config file/2/3.
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� encrypt config file(SrcFileName, EncryptFileName) -> ok | ferror,
Reasong
[page 65] This function encrypts the source config file with DES3 and saves the
result in file EncryptFileName.

� encrypt config file(SrcFileName, EncryptFileName, KeyOrFile) -> ok |
ferror, Reasong
[page 65] This function encrypts the source config file with DES3 and saves the
result in the target file EncryptFileName.

� fail(Reason) -> void()
[page 66] Terminate a test case with the given error Reason.

� get config(Required) -> Value
[page 66] Equivalent to get config(Required, undefined, []).

� get config(Required, Default) -> Value
[page 66] Equivalent to get config(Required, Default, []).

� get config(Required, Default, Opts) -> ValueOrElement
[page 66] Read config data values.

� get status() -> TestStatus | ferror, Reasong
[page 67] Returns status of ongoing tests.

� get target name(Handle) -> fok, TargetNameg | ferror, Reasong
[page 67] Return the name of the target that the given connection belongs to.

� install(Opts) -> ok | ferror, Reasong
[page 67] Install config files and event handlers.

� listenv(Telnet) -> [Env]
[page 68] Performs the listenv command on the given telnet connection and
returns the result as a list of Key-Value pairs.

� log(Format) -> ok
[page 68] Equivalent to log(default, Format, []).

� log(X1, X2) -> ok
[page 68] Equivalent to log(Category, Format, Args).

� log(Category, Format, Args) -> ok
[page 68] Printout from a testcase to the log.

� pal(Format) -> ok
[page 68] Equivalent to pal(default, Format, []).

� pal(X1, X2) -> ok
[page 68] Equivalent to pal(Category, Format, Args).

� pal(Category, Format, Args) -> ok
[page 69] Print and log from a testcase.

� parse table(Data) -> fHeading, Tableg
[page 69] Parse the printout from an SQL table and return a list of tuples.

� print(Format) -> ok
[page 69] Equivalent to print(default, Format, []).

� print(X1, X2) -> term()
[page 69] Equivalent to print(Category, Format, Args).

� print(Category, Format, Args) -> ok
[page 69] Printout from a testcase to the console.

� require(Required) -> ok | ferror, Reasong
[page 69] Check if the required configuration is available.
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� require(Name, Required) -> ok | ferror, Reasong
[page 70] Check if the required configuration is available, and give it a name.

� run(TestDirs) -> Result
[page 70] Run all testcases in all suites in the given directories.

� run(TestDir, Suite) -> Result
[page 70] Run all testcases in the given suite.

� run(TestDir, Suite, Cases) -> Result
[page 71] Run the given testcase(s).

� run test(Opts) -> Result
[page 71] Run tests as specified by the combination of options in Opts.

� run testspec(TestSpec) -> Result
[page 72] Run test specified by TestSpec.

� start interactive() -> ok
[page 72] Start CT in interactive mode.

� step(TestDir, Suite, Case) -> Result
[page 72] Step through a test case with the debugger.

� step(TestDir, Suite, Case, Opts) -> Result
[page 72] Step through a test case with the debugger.

� stop interactive() -> ok
[page 72] Exit the interactive mode.

� testcases(TestDir, Suite) -> Testcases | ferror, Reasong
[page 72] Returns all testcases in the specified suite.

� userdata(TestDir, Suite) -> SuiteUserData | ferror, Reasong
[page 73] Returns any data specified with the tag userdata in the list of tuples
returned from Suite:suite/0.

� userdata(TestDir, Suite, Case) -> TCUserData | ferror, Reasong
[page 73] Returns any data specified with the tag userdata in the list of tuples
returned from Suite:Case/0.

ct cover

The following functions are exported:

� add nodes(Nodes) -> fok, StartedNodesg | ferror, Reasong
[page 74] Add nodes to current cover test (only works if cover support is active!).

� remove nodes(Nodes) -> ok | ferror, Reasong
[page 74] Remove nodes from current cover test.

ct ftp

The following functions are exported:

� cd(Connection, Dir) -> ok | ferror, Reasong
[page 75] Change directory on remote host.

� close(Connection) -> ok | ferror, Reasong
[page 75] Close the FTP connection.

� delete(Connection, File) -> ok | ferror, Reasong
[page 75] Delete a file on remote host.
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� get(KeyOrName, RemoteFile, LocalFile) -> ok | ferror, Reasong
[page 75] Open a ftp connection and fetch a file from the remote host.

� ls(Connection, Dir) -> fok, Listingg | ferror, Reasong
[page 76] List the directory Dir.

� open(KeyOrName) -> fok, Handleg | ferror, Reasong
[page 76] Open an FTP connection to the specified node.

� put(KeyOrName, LocalFile, RemoteFile) -> ok | ferror, Reasong
[page 76] Open a ftp connection and send a file to the remote host.

� recv(Connection, RemoteFile) -> ok | ferror, Reasong
[page 77] Fetch a file over FTP.

� recv(Connection, RemoteFile, LocalFile) -> ok | ferror, Reasong
[page 77] Fetch a file over FTP.

� send(Connection, LocalFile) -> ok | ferror, Reasong
[page 77] Send a file over FTP.

� send(Connection, LocalFile, RemoteFile) -> ok | ferror, Reasong
[page 77] Send a file over FTP.

� type(Connection, Type) -> ok | ferror, Reasong
[page 77] Change file transfer type.

ct master

The following functions are exported:

� abort() -> ok
[page 78] Stops all running tests.

� abort(Nodes) -> ok
[page 78] Stops tests on specified nodes.

� progress() -> [fNode, Statusg]
[page 78] Returns test progress.

� run(TestSpecs) -> ok
[page 78] Equivalent to run(TestSpecs, false, [], []).

� run(TestSpecs, InclNodes, ExclNodes) -> ok
[page 78] Equivalent to run(TestSpecs, false, InclNodes, ExclNodes).

� run(TestSpecs, AllowUserTerms, InclNodes, ExclNodes) -> ok
[page 79] Tests are spawned on the nodes as specified in TestSpecs.

� run on node(TestSpecs, Node) -> ok
[page 79] Equivalent to run on node(TestSpecs, false, Node).

� run on node(TestSpecs, AllowUserTerms, Node) -> ok
[page 79] Tests are spawned on Node according to TestSpecs.

� run test(Node, Opts) -> ok
[page 79] Tests are spawned on Node using ct:run test/1.
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ct rpc

The following functions are exported:

� app node(App, Candidates) -> NodeName
[page 81] From a set of candidate nodes determines which of them is running the
application App.

� app node(App, Candidates, FailOnBadRPC) -> NodeName
[page 81] Same as app node/2 only the FailOnBadRPC argument will determine if
the search for a candidate node should stop or not if badrpc is received at some
point.

� app node(App, Candidates, FailOnBadRPC, Cookie) -> NodeName
[page 81] Same as app node/2 only the FailOnBadRPC argument will determine if
the search for a candidate node should stop or not if badrpc is received at some
point.

� call(Node, Module, Function, Args) -> term() | fbadrpc, Reasong
[page 82] Same as call(Node, Module, Function, Args, infinity).

� call(Node, Module, Function, Args, TimeOut) -> term() | fbadrpc,
Reasong
[page 82] Evaluates apply(Module, Function, Args) on the node Node.

� call(Node, Module, Function, Args, TimeOut, Cookie) -> term() |
fbadrpc, Reasong
[page 82] Evaluates apply(Module, Function, Args) on the node Node.

� cast(Node, Module, Function, Args) -> ok
[page 82] Evaluates apply(Module, Function, Args) on the node Node.

� cast(Node, Module, Function, Args, Cookie) -> ok
[page 83] Evaluates apply(Module, Function, Args) on the node Node.

ct snmp

The following functions are exported:

� get next values(Agent, Oids, MgrAgentConfName) -> SnmpReply
[page 86] Issues a synchronous snmp get next request.

� get values(Agent, Oids, MgrAgentConfName) -> SnmpReply
[page 86] Issues a synchronous snmp get request.

� load mibs(Mibs) -> ok | ferror, Reasong
[page 87] Load the mibs into the agent ’snmp master agent’.

� register agents(MgrAgentConfName, ManagedAgents) -> ok | ferror,
Reasong
[page 87] Explicitly instruct the manager to handle this agent.

� register users(MgrAgentConfName, Users) -> ok | ferror, Reasong
[page 87] Register the manager entity (=user) responsible for specific agent(s).

� register usm users(MgrAgentConfName, UsmUsers) -> ok | ferror,
Reasong
[page 87] Explicitly instruct the manager to handle this USM user.

� set info(Config) -> [fAgent, OldVarsAndVals, NewVarsAndValsg]
[page 87] Returns a list of all successful set requests performed in the test case in
reverse order.
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� set values(Agent, VarsAndVals, MgrAgentConfName, Config) ->
SnmpReply
[page 88] Issues a synchronous snmp set request.

� start(Config, MgrAgentConfName) -> ok
[page 88] Equivalent to start(Config, MgrAgentConfName, undefined).

� start(Config, MgrAgentConfName, SnmpAppConfName) -> ok
[page 88] Starts an snmp manager and/or agent.

� stop(Config) -> ok
[page 88] Stops the snmp manager and/or agent removes all files created.

� unregister agents(MgrAgentConfName) -> ok | ferror, Reasong
[page 88] Removes information added when calling register agents/2.

� unregister users(MgrAgentConfName) -> ok | ferror, Reasong
[page 89] Removes information added when calling register users/2.

� update usm users(MgrAgentConfName, UsmUsers) -> ok | ferror, Reasong
[page 89] Alters information added when calling register usm users/2.

ct ssh

The following functions are exported:

� apread(SSH, Handle, Position, Length) -> Result
[page 91] For info and other types, see ssh sftp(3).

� apread(SSH, Server, Handle, Position, Length) -> Result
[page 91] For info and other types, see ssh sftp(3).

� apwrite(SSH, Handle, Position, Data) -> Result
[page 91] For info and other types, see ssh sftp(3).

� apwrite(SSH, Server, Handle, Position, Data) -> Result
[page 91] For info and other types, see ssh sftp(3).

� aread(SSH, Handle, Len) -> Result
[page 91] For info and other types, see ssh sftp(3).

� aread(SSH, Server, Handle, Len) -> Result
[page 91] For info and other types, see ssh sftp(3).

� awrite(SSH, Handle, Data) -> Result
[page 92] For info and other types, see ssh sftp(3).

� awrite(SSH, Server, Handle, Data) -> Result
[page 92] For info and other types, see ssh sftp(3).

� close(SSH, Handle) -> Result
[page 92] For info and other types, see ssh sftp(3).

� close(SSH, Server, Handle) -> Result
[page 92] For info and other types, see ssh sftp(3).

� connect(KeyOrName) -> fok, Handleg | ferror, Reasong
[page 92] Equivalent to connect(KeyOrName, host, []).

� connect(KeyOrName, ConnType) -> fok, Handleg | ferror, Reasong
[page 92] Equivalent to connect(KeyOrName, ConnType, []).

� connect(KeyOrName, ConnType, ExtraOpts) -> fok, Handleg | ferror,
Reasong
[page 92] Open an SSH or SFTP connection using the information associated with
KeyOrName.
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� del dir(SSH, Name) -> Result
[page 93] For info and other types, see ssh sftp(3).

� del dir(SSH, Server, Name) -> Result
[page 93] For info and other types, see ssh sftp(3).

� delete(SSH, Name) -> Result
[page 93] For info and other types, see ssh sftp(3).

� delete(SSH, Server, Name) -> Result
[page 93] For info and other types, see ssh sftp(3).

� disconnect(SSH) -> ok | ferror, Reasong
[page 94] Close an SSH/SFTP connection.

� exec(SSH, Command) -> fok, Datag | ferror, Reasong
[page 94] Equivalent to exec(SSH, Command, DefaultTimeout).

� exec(SSH, Command, Timeout) -> fok, Datag | ferror, Reasong
[page 94] Requests server to perform Command.

� exec(SSH, ChannelId, Command, Timeout) -> fok, Datag | ferror,
Reasong
[page 94] Requests server to perform Command.

� get file info(SSH, Handle) -> Result
[page 94] For info and other types, see ssh sftp(3).

� get file info(SSH, Server, Handle) -> Result
[page 94] For info and other types, see ssh sftp(3).

� list dir(SSH, Path) -> Result
[page 95] For info and other types, see ssh sftp(3).

� list dir(SSH, Server, Path) -> Result
[page 95] For info and other types, see ssh sftp(3).

� make dir(SSH, Name) -> Result
[page 95] For info and other types, see ssh sftp(3).

� make dir(SSH, Server, Name) -> Result
[page 95] For info and other types, see ssh sftp(3).

� make symlink(SSH, Name, Target) -> Result
[page 95] For info and other types, see ssh sftp(3).

� make symlink(SSH, Server, Name, Target) -> Result
[page 95] For info and other types, see ssh sftp(3).

� open(SSH, File, Mode) -> Result
[page 96] For info and other types, see ssh sftp(3).

� open(SSH, Server, File, Mode) -> Result
[page 96] For info and other types, see ssh sftp(3).

� opendir(SSH, Path) -> Result
[page 96] For info and other types, see ssh sftp(3).

� opendir(SSH, Server, Path) -> Result
[page 96] For info and other types, see ssh sftp(3).

� position(SSH, Handle, Location) -> Result
[page 96] For info and other types, see ssh sftp(3).

� position(SSH, Server, Handle, Location) -> Result
[page 96] For info and other types, see ssh sftp(3).

� pread(SSH, Handle, Position, Length) -> Result
[page 97] For info and other types, see ssh sftp(3).
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� pread(SSH, Server, Handle, Position, Length) -> Result
[page 97] For info and other types, see ssh sftp(3).

� pwrite(SSH, Handle, Position, Data) -> Result
[page 97] For info and other types, see ssh sftp(3).

� pwrite(SSH, Server, Handle, Position, Data) -> Result
[page 97] For info and other types, see ssh sftp(3).

� read(SSH, Handle, Len) -> Result
[page 97] For info and other types, see ssh sftp(3).

� read(SSH, Server, Handle, Len) -> Result
[page 97] For info and other types, see ssh sftp(3).

� read file(SSH, File) -> Result
[page 98] For info and other types, see ssh sftp(3).

� read file(SSH, Server, File) -> Result
[page 98] For info and other types, see ssh sftp(3).

� read file info(SSH, Name) -> Result
[page 98] For info and other types, see ssh sftp(3).

� read file info(SSH, Server, Name) -> Result
[page 98] For info and other types, see ssh sftp(3).

� read link(SSH, Name) -> Result
[page 98] For info and other types, see ssh sftp(3).

� read link(SSH, Server, Name) -> Result
[page 98] For info and other types, see ssh sftp(3).

� read link info(SSH, Name) -> Result
[page 99] For info and other types, see ssh sftp(3).

� read link info(SSH, Server, Name) -> Result
[page 99] For info and other types, see ssh sftp(3).

� receive response(SSH, ChannelId) -> fok, Datag | ferror, Reasong
[page 99] Equivalent to receive response(SSH, ChannelId, close).

� receive response(SSH, ChannelId, End) -> fok, Datag | ferror,
Reasong
[page 99] Equivalent to receive response(SSH, ChannelId, End, DefaultTimeout).

� receive response(SSH, ChannelId, End, Timeout) -> fok, Datag |
ftimeout, Datag | ferror, Reasong
[page 99] Receives expected data from server on the specified session channel.

� rename(SSH, OldName, NewName) -> Result
[page 99] For info and other types, see ssh sftp(3).

� rename(SSH, Server, OldName, NewName) -> Result
[page 100] For info and other types, see ssh sftp(3).

� send(SSH, ChannelId, Data) -> ok | ferror, Reasong
[page 100] Equivalent to send(SSH, ChannelId, 0, Data, DefaultTimeout).

� send(SSH, ChannelId, Data, Timeout) -> ok | ferror, Reasong
[page 100] Equivalent to send(SSH, ChannelId, 0, Data, Timeout).

� send(SSH, ChannelId, Type, Data, Timeout) -> ok | ferror, Reasong
[page 100] Send data to server on specified session channel.

� send and receive(SSH, ChannelId, Data) -> fok, Datag | ferror,
Reasong
[page 100] Equivalent to send and receive(SSH, ChannelId, Data, close).
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� send and receive(SSH, ChannelId, Data, End) -> fok, Datag | ferror,
Reasong
[page 100] Equivalent to send and receive(SSH, ChannelId, 0, Data, End,
DefaultTimeout).

� send and receive(SSH, ChannelId, Data, End, Timeout) -> fok, Datag |
ferror, Reasong
[page 100] Equivalent to send and receive(SSH, ChannelId, 0, Data, End,
Timeout).

� send and receive(SSH, ChannelId, Type, Data, End, Timeout) -> fok,
Datag | ferror, Reasong
[page 100] Send data to server on specified session channel and wait to receive the
server response.

� session close(SSH, ChannelId) -> ok | ferror, Reasong
[page 101] Closes an SSH session channel.

� session open(SSH) -> fok, ChannelIdg | ferror, Reasong
[page 101] Equivalent to session open(SSH, DefaultTimeout).

� session open(SSH, Timeout) -> fok, ChannelIdg | ferror, Reasong
[page 101] Opens a channel for an SSH session.

� sftp connect(SSH) -> fok, Serverg | ferror, Reasong
[page 101] Starts an SFTP session on an already existing SSH connection.

� subsystem(SSH, ChannelId, Subsystem) -> Status | ferror, Reasong
[page 101] Equivalent to subsystem(SSH, ChannelId, Subsystem,
DefaultTimeout).

� subsystem(SSH, ChannelId, Subsystem, Timeout) -> Status | ferror,
Reasong
[page 101] Sends a request to execute a predefined subsystem.

� write(SSH, Handle, Data) -> Result
[page 102] For info and other types, see ssh sftp(3).

� write(SSH, Server, Handle, Data) -> Result
[page 102] For info and other types, see ssh sftp(3).

� write file(SSH, File, Iolist) -> Result
[page 102] For info and other types, see ssh sftp(3).

� write file(SSH, Server, File, Iolist) -> Result
[page 102] For info and other types, see ssh sftp(3).

� write file info(SSH, Name, Info) -> Result
[page 102] For info and other types, see ssh sftp(3).

� write file info(SSH, Server, Name, Info) -> Result
[page 102] For info and other types, see ssh sftp(3).

ct telnet

The following functions are exported:

� close(Connection) -> ok | ferror, Reasong
[page 105] Close the telnet connection and stop the process managing it.

� cmd(Connection, Cmd) -> fok, Datag | ferror, Reasong
[page 105] Equivalent to cmd(Connection, Cmd, DefaultTimeout).
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� cmd(Connection, Cmd, Timeout) -> fok, Datag | ferror, Reasong
[page 105] Send a command via telnet and wait for prompt.

� cmdf(Connection, CmdFormat, Args) -> fok, Datag | ferror, Reasong
[page 105] Equivalent to cmdf(Connection, CmdFormat, Args, DefaultTimeout).

� cmdf(Connection, CmdFormat, Args, Timeout) -> fok, Datag | ferror,
Reasong
[page 105] Send a telnet command and wait for prompt (uses a format string and
list of arguments to build the command).

� cont log(Str, Args) -> term()
[page 105]

� end log() -> term()
[page 105]

� expect(Connection, Patterns) -> term()
[page 105] Equivalent to expect(Connections, Patterns, []).

� expect(Connection, Patterns, Opts) -> fok, Matchg | fok, MatchList,
HaltReasong | ferror, Reasong
[page 105] Get data from telnet and wait for the expected pattern.

� get data(Connection) -> fok, Datag | ferror, Reasong
[page 107] Get all data which has been received by the telnet client since last
command was sent.

� open(Name) -> fok, Handleg | ferror, Reasong
[page 107] Equivalent to open(Name, telnet).

� open(Name, ConnType) -> fok, Handleg | ferror, Reasong
[page 107] Open a telnet connection to the specified target host.

� open(KeyOrName, ConnType, TargetMod) -> fok, Handleg | ferror,
Reasong
[page 107] Equivalent to open(KeyOrName, ConnType, TargetMod, []).

� open(KeyOrName, ConnType, TargetMod, Extra) -> fok, Handleg |
ferror, Reasong
[page 107] Open a telnet connection to the specified target host.

� send(Connection, Cmd) -> ok | ferror, Reasong
[page 108] Send a telnet command and return immediately.

� sendf(Connection, CmdFormat, Args) -> ok | ferror, Reasong
[page 108] Send a telnet command and return immediately (uses a format string
and a list of arguments to build the command).

unix telnet

No functions are exported.
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Common Test
Application

The Common Test framework is an environment for implementing and performing
automatic and semi-automatic execution of test cases. Common Test uses the OTP Test
Server as engine for test case execution and logging.

In brief, Common Test supports:

� Automated execution of test suites (sets of test cases).

� Logging of the events during execution.

� HTML presentation of test suite results.

� HTML presentation of test suite code.

� Support functions for test suite authors.

� Step by step execution of test cases.

The following sections describe the mandatory and optional test suite functions
Common Test will call during test execution. For more details see Common Test User’s
Guide. [page 4]

TEST CASE CALLBACK FUNCTIONS

The following functions define the callback interface for a test suite.

Exports

Module:all() -> TestCases | fskip,Reasong

Types:

� TestCases = [atom() | fgroup,GroupNameg]
� Reason = term()
� GroupName = atom()
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MANDATORY

This function must return the list of all test cases and test case groups in the test suite
module that are to be executed. This list also specifies the order the cases and groups
will be executed by Common Test. A test case is represented by an atom, the name of
the test case function. A test case group is represented by a fgroup,GroupNameg tuple,
where GroupName, an atom, is the name of the group (defined with groups/0).

If fskip,Reasong is returned, all test cases in the module will be skipped, and the
Reason will be printed on the HTML result page.

For details on groups, see Test case groups [page 8] in the User’s Guide.

Module:groups() -> GroupDefs

Types:

� GroupDefs = [Group]
� Group = fGroupName,Properties,GroupsAndTestCasesg
� GroupName = atom()
� Properties = [parallel | sequence | Shuffle | fRepeatType,Ng]
� GroupsAndTestCases = [Group | fgroup,GroupNameg | TestCase]
� TestCase = atom()
� Shuffle = shuffle | fshuffle,Seedg
� Seed = finteger(),integer(),integer()g
� RepeatType = repeat | repeat until all ok | repeat until all fail | repeat until any ok
| repeat until any fail

� N = integer() | forever

OPTIONAL

See Test case groups [page 8] in the User’s Guide for details.

Module:suite() -> [Info]

Types:

� Info = ftimetrap,Timeg | frequire,Requiredg | frequire,Name,Requiredg |
fuserdata,UserDatag | fsilent connections,Connsg | fstylesheet,CSSFileg

� Time = MilliSec | fseconds,integer()g | fminutes,integer()g | fhours,integer()g
� MilliSec = integer()
� Required = Key | fKey,SubKeysg
� Key = atom()
� SubKeys = SubKey | [SubKey]
� SubKey = atom()
� Name = atom()
� UserData = term()
� Conns = [atom()]
� CSSFile = string()

57Common Test



Common Test Common Test Reference Manual

OPTIONAL

This is the test suite info function. It is supposed to return a list of tagged tuples that
specify various properties regarding the execution of this test suite (common for all test
cases in the suite).

The timetrap tag sets the maximum time each test case is allowed to take (including
init per testcase/2 and end per testcase/2). If the timetrap time is exceeded, the
test case fails with reason timetrap timeout.

The require tag specifies configuration variables that are required by test cases in the
suite. If the required configuration variables are not found in any of the configuration
files, all test cases are skipped. For more information about the ’require’ functionality,
see the reference manual for the function ct:require/[1,2].

With userdata, it is possible for the user to specify arbitrary test suite related
information which can be read by calling ct:userdata/2.

Other tuples than the ones defined will simply be ignored.

For more information about the test suite info function, see Test suite info function
[page 8] in the User’s Guide.

Module:init per suite(Config) -> NewConfig | fskip,Reasong |
fskip and save,Reason,SaveConfigg

Types:

� Config = NewConfig = SaveConfig = [fKey,Valueg]
� Key = atom()
� Value = term()
� Reason = term()

OPTIONAL

This function is called as the first function in the suite. It typically contains initialization
which is common for all test cases in the suite, and which shall only be done once. The
Config parameter is the configuration which can be modified here. Whatever is
returned from this function is given as Config to all configuration functions and test
cases in the suite. If fskip,Reasong is returned, all test cases in the suite will be
skipped and Reason printed in the overview log for the suite.

For information on save config and skip and save, please see Dependencies between
Test Cases and Suites [page 41] in the User’s Guide.

Module:end per suite(Config) -> void() | fsave config,SaveConfigg

Types:

� Config = SaveConfig = [fKey,Valueg]
� Key = atom()
� Value = term()

OPTIONAL

This function is called as the last test case in the suite. It is meant to be used for
cleaning up after init per suite/1. For information on save config, please see
Dependencies between Test Cases and Suites [page 41] in the User’s Guide.

Module:init per group(GroupName, Config) -> NewConfig | fskip,Reasong

Types:
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� GroupName = atom()
� Config = NewConfig = [fKey,Valueg]
� Key = atom()
� Value = term()
� Reason = term()

OPTIONAL

This function is called before execution of a test case group. It typically contains
initialization which is common for all test cases in the group, and which shall only be
performed once. GroupName is the name of the group, as specified in the group
definition (see groups/0). The Config parameter is the configuration which can be
modified here. Whatever is returned from this function is given as Config to all test
cases in the group. If fskip,Reasong is returned, all test cases in the group will be
skipped and Reason printed in the overview log for the group.

For information about test case groups, please see Test case groups [page 8] chapter in
the User’s Guide.

Module:end per group(GroupName, Config) -> void() | freturn group result,Statusg

Types:

� GroupName = atom()
� Config = [fKey,Valueg]
� Key = atom()
� Value = term()
� Status = ok | skipped | failed

OPTIONAL

This function is called after the execution of a test case group is finished. It is meant to
be used for cleaning up after init per group/2. By means of
freturn group result,Statusg, it is possible to return a status value for a nested
sub-group. The status can be retrieved in end per group/2 for the group on the level
above. The status will also be used by Common Test for deciding if execution of a
group should proceed in case the property sequence or repeat until * is set.

For more information about test case groups, please see Test case groups [page 8]
chapter in the User’s Guide.

Module:init per testcase(TestCase, Config) -> NewConfig | fskip,Reasong

Types:

� TestCase = atom()
� Config = NewConfig = [fKey,Valueg]
� Key = atom()
� Value = term()
� Reason = term()

OPTIONAL

This function is called before each test case. The TestCase argument is the name of the
test case, and Config is the configuration which can be modified here. Whatever is
returned from this function is given as Config to the test case. If fskip,Reasong is
returned, the test case will be skipped and Reason printed in the overview log for the
suite.
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Module:end per testcase(TestCase, Config) -> void() | fsave config,SaveConfigg

Types:

� TestCase = atom()
� Config = SaveConfig = [fKey,Valueg]
� Key = atom()
� Value = term()

OPTIONAL

This function is called after each test case, and can be used to clean up after
init per testcase/2 and the test case. Any return value (besides
fsave config,SaveConfigg) is ignored. For information on save config, please see
Dependencies between Test Cases and Suites [page 41] in the User’s Guide

Module:testcase() -> [Info]

Types:

� Info = ftimetrap,Timeg | frequire,Requiredg | frequire,Name,Requiredg |
fuserdata,UserDatag | fsilent connections,Connsg

� Time = MilliSec | fseconds,integer()g | fminutes,integer()g | fhours,integer()g
� MilliSec = integer()
� Required = Key | fKey,SubKeysg
� Key = atom()
� SubKeys = SubKey | [SubKey]
� SubKey = atom()
� Name = atom()
� UserData = term()
� Conns = [atom()]

OPTIONAL

This is the test case info function. It is supposed to return a list of tagged tuples that
specify various properties regarding the execution of this particular test case.

The timetrap tag sets the maximum time the test case is allowed to take. If the
timetrap time is exceeded, the test case fails with reason timetrap timeout.
init per testcase/2 and end per testcase/2 are included in the timetrap time.

The require tag specifies configuration variables that are required by the test case. If
the required configuration variables are not found in any of the configuration files, the
test case is skipped. For more information about the ’require’ functionality, see the
reference manual for the function ct:require/[1,2].

If timetrap and/or require is not set, the default values specified in the suite/0
return list will be used.

With userdata, it is possible for the user to specify arbitrary test case related
information which can be read by calling ct:userdata/3.

Other tuples than the ones defined will simply be ignored.

For more information about the test case info function, see Test case info function [page
6] in the User’s Guide.

Module:testcase(Config) -> void() | fskip,Reasong | fcomment,Commentg |
fsave config,SaveConfigg | fskip and save,Reason,SaveConfigg | exit()
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Types:

� Config = SaveConfig = [fKey,Valueg]
� Key = atom()
� Value = term()
� Reason = term()
� Comment = string()

MANDATORY

This is the implementation of a test case. Here you must call the functions you want to
test, and do whatever you need to check the result. If someting fails, make sure the
function causes a runtime error, or call ct:fail/[0,1] (which also causes the test case
process to crash).

Elements from the Config parameter can be read with the ?config macro. The config
macro is defined in ct.hrl

You can return fskip,Reasong if you decide not to run the test case after all. Reason
will then be printed in ’Comment’ field on the HTML result page.

You can return fcomment,Commentg if you wish to print some information in the
’Comment’ field on the HTML result page.

If the function returns anything else, the test case is considered successful. (The return
value always gets printed in the test case log file).

For more information about test case implementation, please see Test cases [page 6] in
the User’s Guide.

For information on save config and skip and save, please see Dependencies between
Test Cases and Suites [page 41] in the User’s Guide.
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The run test shell script
Application

The run test script is automatically generated as Common Test is installed (please see
the Installation chapter in the Common Test User’s Guide for more information). The
script accepts a number of different start flags. Some flags trigger run test to start the
Common Test application and pass on data to it. Some flags start an Erlang node
prepared for running Common Test in a particular mode.

run test also accepts Erlang emulator flags. These are used when run test calls erl to
start the Erlang node (making it possible to e.g. add directories to the code server path,
change the cookie on the node, start additional applications, etc).

If run test is called without parameters, it prints all valid start flags to stdout.

Run tests from command line

run test [-dir TestDir1 TestDir2 .. TestDirN] |
[-suite Suite1 Suite2 .. SuiteN
[[-group Group1 Group2 .. GroupN] [-case Case1 Case2 .. CaseN]]]
[-step [config | keep inactive]]
[-config ConfigFile1 ConfigFile2 .. ConfigFileN]
[-decrypt key Key] | [-decrypt file KeyFile]
[-logdir LogDir]
[-silent connections [ConnType1 ConnType2 .. ConnTypeN]]
[-stylesheet CSSFile]
[-cover CoverCfgFile]
[-event handler EvHandler1 EvHandler2 .. EvHandlerN]
[-include InclDir1 InclDir2 .. InclDirN]
[-no auto compile]
[-repeat N [-force stop]] |
[-duration HHMMSS [-force stop]] |
[-until [YYMoMoDD]HHMMSS [-force stop]]

Run tests using test specification

run test -spec TestSpec1 TestSpec2 .. TestSpecN
[-config ConfigFile1 ConfigFile2 .. ConfigFileN]
[-decrypt key Key] | [-decrypt file KeyFile]
[-logdir LogDir]
[-allow user terms]
[-silent connections [ConnType1 ConnType2 .. ConnTypeN]]
[-stylesheet CSSFile]
[-cover CoverCfgFile]
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[-event handler EvHandler1 EvHandler2 .. EvHandlerN]
[-include InclDir1 InclDir2 .. InclDirN]
[-no auto compile]
[-repeat N [-force stop]] |
[-duration HHMMSS [-force stop]] |
[-until [YYMoMoDD]HHMMSS [-force stop]]

Run tests in web based GUI

run test -vts [-browser Browser]
[-config ConfigFile1 ConfigFile2 .. ConfigFileN]
[-decrypt key Key] | [-decrypt file KeyFile]
[-dir TestDir1 TestDir2 .. TestDirN] |
[-suite Suite [[-group Group] [-case Case]]]
[-include InclDir1 InclDir2 .. InclDirN]
[-no auto compile]

Refresh the HTML index files

run test -refresh logs [-logdir LogDir]

Run CT in interactive mode

run test -shell
[-config ConfigFile1 ConfigFile2 ... ConfigFileN]
[-decrypt key Key] | [-decrypt file KeyFile]

Start an Erlang node with a given name

run test -ctname NodeName

Start a Common Test Master node

run test -ctmaster

See also

Please read the Running Test Suites [page 16] chapter in the Common Test User’s
Guide for information about the meaning of the different start flags.
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ct
Erlang Module

Main user interface for the Common Test framework.

This module implements the command line interface for running tests and some basic
functions for common test case issues such as configuration and logging.

Test Suite Support Macros

The config macro is defined in ct.hrl. This macro should be used to retrieve
information from the Config variable sent to all test cases. It is used with two
arguments, where the first is the name of the configuration variable you wish to retrieve,
and the second is the Config variable supplied to the test case.

Possible configuration variables include:

� data dir - Data file directory.

� priv dir - Scratch file directory.

� Whatever added by init per suite/1 or init per testcase/2 in the test suite.

DATA TYPES

handle() = handle() (see module ct gen conn) | term() The identity of a
specific connection.

target name() = var name() The name of a target.

var name() = atom() A variable name which is specified when ct:require/2 is
called, e.g. ct:require(mynodename,fnode,[telnet]g)

Exports

abort current testcase(Reason) -> ok | ferror, no testcase runningg

Types:

� Reason = term()

When calling this function, the currently executing test case will be aborted. It is the
user’s responsibility to know for sure which test case is currently executing. The
function is therefore only safe to call from a function which has been called (or
synchronously invoked) by the test case.

Reason, the reason for aborting the test case, is printed in the test case log.

comment(Comment) -> void()

Types:
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� Comment = term()

Print the given Comment in the comment field of the table on the test suite result page.

If called several times, only the last comment is printed. comment/1 is also overwritten
by the return value fcomment,Commentg or by the function fail/1 (which prints
Reason as a comment).

decrypt config file(EncryptFileName, TargetFileName) -> ok | ferror, Reasong

Types:

� EncryptFileName = string()
� TargetFileName = string()
� Reason = term()

This function decrypts EncryptFileName, previously generated with
encrypt config file/2/3. The original file contents is saved in the target file. The
encryption key, a string, must be available in a text file named .ct config.crypt in the
current directory, or the home directory of the user (it is searched for in that order).

decrypt config file(EncryptFileName, TargetFileName, KeyOrFile) -> ok | ferror,
Reasong

Types:

� EncryptFileName = string()
� TargetFileName = string()
� KeyOrFile = fkey, string()g | ffile, string()g
� Reason = term()

This function decrypts EncryptFileName, previously generated with
encrypt config file/2/3. The original file contents is saved in the target file. The key
must have the the same value as that used for encryption.

encrypt config file(SrcFileName, EncryptFileName) -> ok | ferror, Reasong

Types:

� SrcFileName = string()
� EncryptFileName = string()
� Reason = term()

This function encrypts the source config file with DES3 and saves the result in file
EncryptFileName. The key, a string, must be available in a text file named
.ct config.crypt in the current directory, or the home directory of the user (it is
searched for in that order).

See the Common Test User’s Guide for information about using encrypted config files
when running tests.

See the crypto application for details on DES3 encryption/decryption.

encrypt config file(SrcFileName, EncryptFileName, KeyOrFile) -> ok | ferror, Reasong

Types:

� SrcFileName = string()
� EncryptFileName = string()
� KeyOrFile = fkey, string()g | ffile, string()g
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� Reason = term()

This function encrypts the source config file with DES3 and saves the result in the
target file EncryptFileName. The encryption key to use is either the value in fkey,Keyg
or the value stored in the file specified by ffile,Fileg.

See the Common Test User’s Guide for information about using encrypted config files
when running tests.

See the crypto application for details on DES3 encryption/decryption.

fail(Reason) -> void()

Types:

� Reason = term()

Terminate a test case with the given error Reason.

get config(Required) -> Value

Equivalent to get config(Required, undefined, []) [page 66].

get config(Required, Default) -> Value

Equivalent to get config(Required, Default, []) [page 66].

get config(Required, Default, Opts) -> ValueOrElement

Types:

� Required = KeyOrName | fKeyOrName, SubKeyg
� KeyOrName = atom()
� SubKey = atom()
� Default = term()
� Opts = [Opt] | []
� Opt = element | all
� ValueOrElement = term() | Default

Read config data values.

This function returns the matching value(s) or config element(s), given a config variable
key or its associated name (if one has been specified with require/2 or a require
statement).

Example, given the following config file:

funix,[ftelnet,IpAddrg,
fusername,Usernameg,
fpassword,Passwordg]g.
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get config(unix,Default) -> [ftelnet,IpAddrg, fusername,Usernameg,
fpassword,Passwordg]
get config(funix,telnetg,Default) -> IpAddr
get config(funix,ftpg,Default) -> Default
get config(unknownkey,Default) -> Default

If a config variable key has been associated with a name (by means of require/2 or a
require statement), the name may be used instead of the key to read the value:

require(myhost,unix) -> ok
get config(myhost,Default) -> [ftelnet,IpAddrg, fusername,Usernameg,
fpassword,Passwordg]

If a config variable is defined in multiple files and you want to access all possible values,
use the all option. The values will be returned in a list and the order of the elements
corresponds to the order that the config files were specified at startup.

If you want config elements (key-value tuples) returned as result instead of values, use
the element option. The returned elements will then be on the form
fKeyOrName,Valueg, or (in case a subkey has been specified)
ffKeyOrName,SubKeyg,Valueg

See also: get config/1 [page 66], get config/2 [page 66], require/1 [page 70], require/2
[page 70].

get status() -> TestStatus | ferror, Reasong

Types:

� TestDir = term()
� Reason = term()

Returns status of ongoing tests.

get target name(Handle) -> fok, TargetNameg | ferror, Reasong

Types:

� Handle = handle()
� TargetName = target name()

Return the name of the target that the given connection belongs to.

install(Opts) -> ok | ferror, Reasong

Types:

� Opts = [Opt]
� Opt = fconfig, ConfigFilesg | fevent handler, Modulesg | fdecrypt, KeyOrFileg
� ConfigFiles = [ConfigFile]
� ConfigFile = string()
� Modules = [atom()]
� KeyOrFile = fkey, Keyg | ffile, KeyFileg
� Key = string()
� KeyFile = string()
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Install config files and event handlers.

Run this function once before first test.

Example:
install([fconfig,["config node.ctc","config user.ctc"]g]).

Note that this function is automatically run by the run test script.

listenv(Telnet) -> [Env]

Types:

� Telnet = term()
� Env = fKey, Valueg
� Key = string()
� Value = string()

Performs the listenv command on the given telnet connection and returns the result as a
list of Key-Value pairs.

log(Format) -> ok

Equivalent to log(default, Format, []) [page 68].

log(X1, X2) -> ok

Types:

� X1 = Category | Format
� X2 = Format | Args

Equivalent to log(Category, Format, Args) [page 68].

log(Category, Format, Args) -> ok

Types:

� Category = atom()
� Format = string()
� Args = list()

Printout from a testcase to the log.

This function is meant for printing stuff directly from a testcase (i.e. not from within
the CT framework) in the test log.

Default Category is default and default Args is [].

pal(Format) -> ok

Equivalent to pal(default, Format, []) [page 69].

pal(X1, X2) -> ok

Types:

� X1 = Category | Format
� X2 = Format | Args

Equivalent to pal(Category, Format, Args) [page 69].
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pal(Category, Format, Args) -> ok

Types:

� Category = atom()
� Format = string()
� Args = list()

Print and log from a testcase.

This function is meant for printing stuff from a testcase both in the log and on the
console.

Default Category is default and default Args is [].

parse table(Data) -> fHeading, Tableg

Types:

� Data = [string()]
� Heading = tuple()
� Table = [tuple()]

Parse the printout from an SQL table and return a list of tuples.

The printout to parse would typically be the result of a select command in SQL. The
returned Table is a list of tuples, where each tuple is a row in the table.

Heading is a tuple of strings representing the headings of each column in the table.

print(Format) -> ok

Equivalent to print(default, Format, []) [page 69].

print(X1, X2) -> term()

Equivalent to print(Category, Format, Args) [page 69].

print(Category, Format, Args) -> ok

Types:

� Category = atom()
� Format = string()
� Args = list()

Printout from a testcase to the console.

This function is meant for printing stuff from a testcase on the console.

Default Category is default and default Args is [].

require(Required) -> ok | ferror, Reasong

Types:

� Required = Key | fKey, SubKeysg
� Key = atom()
� SubKeys = SubKey | [SubKey]
� SubKey = atom()
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Check if the required configuration is available.

Example: require the variable myvar:
ok = ct:require(myvar)

In this case the config file must at least contain:

fmyvar,Valueg.

Example: require the variable myvar with subvariable sub1:
ok = ct:require(fmyvar,sub1g)

In this case the config file must at least contain:

fmyvar,[fsub1,Valueg]g.

See also: get config/1 [page 66], get config/2 [page 66], get config/3 [page 66],
require/2 [page 70].

require(Name, Required) -> ok | ferror, Reasong

Types:

� Name = atom()
� Required = Key | fKey, SubKeysg
� Key = atom()
� SubKeys = SubKey | [SubKey]
� SubKey = atom()

Check if the required configuration is available, and give it a name.

If the requested data is available, the main entry will be associated with Name so that the
value of the element can be read with get config/1,2 provided Name instead of the
Key.

Example: Require one node with a telnet connection and an ftp connection. Name the
node a:
ok = ct:require(a,fnode,[telnet,ftp]g).
All references to this node may then use the node name. E.g. you can fetch a file over
ftp like this:
ok = ct:ftp get(a,RemoteFile,LocalFile).

For this to work, the config file must at least contain:

fnode,[ftelnet,IpAddrg,
fftp,IpAddrg]g.

See also: get config/1 [page 66], get config/2 [page 66], get config/3 [page 66],
require/1 [page 70].

run(TestDirs) -> Result

Types:

� TestDirs = TestDir | [TestDir]

Run all testcases in all suites in the given directories.

See also: run/3 [page 71].

run(TestDir, Suite) -> Result
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Run all testcases in the given suite.

See also: run/3 [page 71].

run(TestDir, Suite, Cases) -> Result

Types:

� TestDir = string()
� Suite = atom()
� Cases = atom() | [atom()]
� Result = [TestResult] | ferror, Reasong

Run the given testcase(s).

Requires that ct:install/1 has been run first.

Suites (* SUITE.erl) files must be stored in TestDir or TestDir/test. All suites will be
compiled when test is run.

run test(Opts) -> Result

Types:

� Opts = [OptTuples]
� OptTuples = fconfig, CfgFilesg | fdir, TestDirsg | fsuite, Suitesg | ftestcase, Casesg
| fgroup, Groupsg | f’spec’, TestSpecsg | fallow user terms, Boolg | flogdir,
LogDirg | fsilent connections, Connsg | fcover, CoverSpecFileg | fstep, StepOptsg
| fevent handler, EventHandlersg | finclude, InclDirsg | fauto compile, Boolg |
frepeat, Ng | fduration, DurTimeg | funtil, StopTimeg | fforce stop, Boolg |
fdecrypt, DecryptKeyOrFileg

� CfgFiles = [string()] | string()
� TestDirs = [string()] | string()
� Suites = [string()] | string()
� Cases = [atom()] | atom()
� Groups = [atom()] | atom()
� TestSpecs = [string()] | string()
� LogDir = string()
� Conns = all | [atom()]
� CoverSpecFile = string()
� StepOpts = [StepOpt] | []
� StepOpt = config | keep inactive
� EventHandlers = EH | [EH]
� EH = atom() | fatom(), InitArgsg | f[atom()], InitArgsg
� InitArgs = [term()]
� InclDirs = [string()] | string()
� N = integer()
� DurTime = string(HHMMSS)
� StopTime = string(YYMoMoDDHHMMSS) | string(HHMMSS)
� DecryptKeyOrFile = fkey, DecryptKeyg | ffile, DecryptFileg
� DecryptKey = string()
� DecryptFile = string()
� Result = [TestResult] | ferror, Reasong
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Run tests as specified by the combination of options in Opts. The options are the same
as those used with the run test script. Note that here a TestDir can be used to point
out the path to a Suite. Note also that the option testcase corresponds to the -case
option in the run test script. Configuration files specified in Opts will be installed
automatically at startup.

run testspec(TestSpec) -> Result

Types:

� TestSpec = [term()]

Run test specified by TestSpec. The terms are the same as those used in test
specification files.

start interactive() -> ok

Start CT in interactive mode.

From this mode all test case support functions can be executed directly from the erlang
shell. The interactive mode can also be started from the unix command line with
run test -shell [-config File...].

If any functions using “required config data” (e.g. telnet or ftp functions) are to be called
from the erlang shell, config data must first be required with ct:require/2.

Example:
> ct:require(a,funix,[telnet]g).
ok
> ct:cmd(a,"ls").
fok,["ls","file1 ...",...]g

step(TestDir, Suite, Case) -> Result

Types:

� Case = atom()

Step through a test case with the debugger.

See also: run/3 [page 71].

step(TestDir, Suite, Case, Opts) -> Result

Types:

� Case = atom()
� Opts = [Opt] | []
� Opt = config | keep inactive

Step through a test case with the debugger. If the config option has been given,
breakpoints will be set also on the configuration functions in Suite.

See also: run/3 [page 71].

stop interactive() -> ok

Exit the interactive mode.

See also: start interactive/0 [page 72].

testcases(TestDir, Suite) -> Testcases | ferror, Reasong

72 Common Test



Common Test Reference Manual ct

Types:

� TestDir = string()
� Suite = atom()
� Testcases = list()
� Reason = term()

Returns all testcases in the specified suite.

userdata(TestDir, Suite) -> SuiteUserData | ferror, Reasong

Types:

� TestDir = string()
� Suite = atom()
� SuiteUserData = [term()]
� Reason = term()

Returns any data specified with the tag userdata in the list of tuples returned from
Suite:suite/0.

userdata(TestDir, Suite, Case) -> TCUserData | ferror, Reasong

Types:

� TestDir = string()
� Suite = atom()
� Case = atom()
� TCUserData = [term()]
� Reason = term()

Returns any data specified with the tag userdata in the list of tuples returned from
Suite:Case/0.
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ct cover
Erlang Module

Common Test Framework code coverage support module.

This module exports help functions for performing code coverage analysis.

Exports

add nodes(Nodes) -> fok, StartedNodesg | ferror, Reasong

Types:

� Nodes = [atom()]
� StartedNodes = [atom()]
� Reason = cover not running | not main node

Add nodes to current cover test (only works if cover support is active!). To have effect,
this function should be called from init per suite/1 before any actual tests are
performed.

remove nodes(Nodes) -> ok | ferror, Reasong

Types:

� Nodes = [atom()]
� Reason = cover not running | not main node

Remove nodes from current cover test. Call this function to stop cover test on nodes
previously added with add nodes/1. Results on the remote node are transferred to the
Common Test node.
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ct ftp
Erlang Module

FTP client module (based on the FTP support of the INETS application).

DATA TYPES

connection() = handle() | target name() (see module ct)

handle() = handle() (see module ct gen conn) Handle for a specific ftp
connection.

Exports

cd(Connection, Dir) -> ok | ferror, Reasong

Types:

� Connection = connection()
� Dir = string()

Change directory on remote host.

close(Connection) -> ok | ferror, Reasong

Types:

� Connection = connection()

Close the FTP connection.

delete(Connection, File) -> ok | ferror, Reasong

Types:

� Connection = connection()
� File = string()

Delete a file on remote host

get(KeyOrName, RemoteFile, LocalFile) -> ok | ferror, Reasong

Types:

� KeyOrName = Key | Name
� Key = atom()
� Name = target name() (see module ct)
� RemoteFile = string()
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� LocalFile = string()

Open a ftp connection and fetch a file from the remote host.

RemoteFile and LocalFile must be absolute paths.

The config file must be as for put/3.

See also: put/3 [page 76].

ls(Connection, Dir) -> fok, Listingg | ferror, Reasong

Types:

� Connection = connection()
� Dir = string()
� Listing = string()

List the directory Dir.

open(KeyOrName) -> fok, Handleg | ferror, Reasong

Types:

� KeyOrName = Key | Name
� Key = atom()
� Name = target name() (see module ct)
� Handle = handle()

Open an FTP connection to the specified node.

You can open one connection for a particular Name and use the same name as reference
for all subsequent operations. If you want the connection to be associated with Handle
instead (in case you need to open multiple connections to a host for example), simply
use Key, the configuration variable name, to specify the target. Note that a connection
that has no associated target name can only be closed with the handle value.

put(KeyOrName, LocalFile, RemoteFile) -> ok | ferror, Reasong

Types:

� KeyOrName = Key | Name
� Key = atom()
� Name = target name() (see module ct)
� LocalFile = string()
� RemoteFile = string()

Open a ftp connection and send a file to the remote host.

LocalFile and RemoteFile must be absolute paths.

If the target host is a “special” node, the ftp address must be specified in the config file
like this:

fnode,[fftp,IpAddrg]g.

If the target host is something else, e.g. a unix host, the config file must also include the
username and password (both strings):

funix,[fftp,IpAddrg,
fusername,Usernameg,
fpassword,Passwordg]g.
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recv(Connection, RemoteFile) -> ok | ferror, Reasong

Fetch a file over FTP.

The file will get the same name on the local host.

See also: recv/3 [page 77].

recv(Connection, RemoteFile, LocalFile) -> ok | ferror, Reasong

Types:

� Connection = connection()
� RemoteFile = string()
� LocalFile = string()

Fetch a file over FTP.

The file will be named LocalFile on the local host.

send(Connection, LocalFile) -> ok | ferror, Reasong

Send a file over FTP.

The file will get the same name on the remote host.

See also: send/3 [page 77].

send(Connection, LocalFile, RemoteFile) -> ok | ferror, Reasong

Types:

� Connection = connection()
� LocalFile = string()
� RemoteFile = string()

Send a file over FTP.

The file will be named RemoteFile on the remote host.

type(Connection, Type) -> ok | ferror, Reasong

Types:

� Connection = connection()
� Type = ascii | binary

Change file transfer type
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ct master
Erlang Module

Distributed test execution control for Common Test.

This module exports functions for running Common Test nodes on multiple hosts in
parallel.

Exports

abort() -> ok

Stops all running tests.

abort(Nodes) -> ok

Types:

� Nodes = atom() | [atom()]

Stops tests on specified nodes.

progress() -> [fNode, Statusg]

Types:

� Node = atom()
� Status = finished ok | ongoing | aborted | ferror, Reasong
� Reason = term()

Returns test progress. If Status is ongoing, tests are running on the node and have not
yet finished.

run(TestSpecs) -> ok

Types:

� TestSpecs = string() | [SeparateOrMerged]

Equivalent to run(TestSpecs, false, [], []) [page 79].

run(TestSpecs, InclNodes, ExclNodes) -> ok

Types:

� TestSpecs = string() | [SeparateOrMerged]
� SeparateOrMerged = string() | [string()]
� InclNodes = [atom()]
� ExclNodes = [atom()]
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Equivalent to run(TestSpecs, false, InclNodes, ExclNodes) [page 79].

run(TestSpecs, AllowUserTerms, InclNodes, ExclNodes) -> ok

Types:

� TestSpecs = string() | [SeparateOrMerged]
� SeparateOrMerged = string() | [string()]
� AllowUserTerms = bool()
� InclNodes = [atom()]
� ExclNodes = [atom()]

Tests are spawned on the nodes as specified in TestSpecs. Each specification in
TestSpec will be handled separately. It is however possible to also specify a list of
specifications that should be merged into one before the tests are executed. Any test
without a particular node specification will also be executed on the nodes in InclNodes.
Nodes in the ExclNodes list will be excluded from the test.

run on node(TestSpecs, Node) -> ok

Types:

� TestSpecs = string() | [SeparateOrMerged]
� SeparateOrMerged = string() | [string()]
� Node = atom()

Equivalent to run on node(TestSpecs, false, Node) [page 79].

run on node(TestSpecs, AllowUserTerms, Node) -> ok

Types:

� TestSpecs = string() | [SeparateOrMerged]
� SeparateOrMerged = string() | [string()]
� AllowUserTerms = bool()
� Node = atom()

Tests are spawned on Node according to TestSpecs.

run test(Node, Opts) -> ok

Types:

� Node = atom()
� Opts = [OptTuples]
� OptTuples = fconfig, CfgFilesg | fdir, TestDirsg | fsuite, Suitesg | ftestcase, Casesg
| f’spec’, TestSpecsg | fallow user terms, Boolg | flogdir, LogDirg | fevent handler,
EventHandlersg | fsilent connections, Connsg | fcover, CoverSpecFileg

� CfgFiles = string() | [string()]
� TestDirs = string() | [string()]
� Suites = atom() | [atom()]
� Cases = atom() | [atom()]
� TestSpecs = string() | [string()]
� LogDir = string()
� EventHandlers = EH | [EH]
� EH = atom() | fatom(), InitArgsg | f[atom()], InitArgsg
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� InitArgs = [term()]
� Conns = all | [atom()]

Tests are spawned on Node using ct:run test/1.
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ct rpc
Erlang Module

Common Test specific layer on Erlang/OTP rpc.

Exports

app node(App, Candidates) -> NodeName

Types:

� App = atom()
� Candidates = [NodeName]
� NodeName = atom()

From a set of candidate nodes determines which of them is running the application
App. If none of the candidate nodes is running the application the function will make
the test case calling this function fail. This function is the same as calling
app node(App, Candidates, true).

app node(App, Candidates, FailOnBadRPC) -> NodeName

Types:

� App = atom()
� Candidates = [NodeName]
� NodeName = atom()
� FailOnBadRPC = true | false

Same as app node/2 only the FailOnBadRPC argument will determine if the search for a
candidate node should stop or not if badrpc is received at some point.

app node(App, Candidates, FailOnBadRPC, Cookie) -> NodeName

Types:

� App = atom()
� Candidates = [NodeName]
� NodeName = atom()
� FailOnBadRPC = true | false
� Cookie = atom()

Same as app node/2 only the FailOnBadRPC argument will determine if the search for a
candidate node should stop or not if badrpc is received at some point. The cookie on
the client node will be set to Cookie for this rpc operation (use to match the server
node cookie).
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call(Node, Module, Function, Args) -> term() | fbadrpc, Reasong

Same as call(Node, Module, Function, Args, infinity)

call(Node, Module, Function, Args, TimeOut) -> term() | fbadrpc, Reasong

Types:

� Node = NodeName | fFun, FunArgsg
� Fun = fun()
� FunArgs = term()
� NodeName = atom()
� Module = atom()
� Function = atom()
� Args = [term()]
� Reason = timeout | term()

Evaluates apply(Module, Function, Args) on the node Node. Returns whatever
Function returns or fbadrpc, Reasong if the remote procedure call fails. If Node is fFun,
FunArgsg applying Fun to FunArgs should return a node name.

call(Node, Module, Function, Args, TimeOut, Cookie) -> term() | fbadrpc, Reasong

Types:

� Node = NodeName | fFun, FunArgsg
� Fun = fun()
� FunArgs = term()
� NodeName = atom()
� Module = atom()
� Function = atom()
� Args = [term()]
� Reason = timeout | term()
� Cookie = atom()

Evaluates apply(Module, Function, Args) on the node Node. Returns whatever
Function returns or fbadrpc, Reasong if the remote procedure call fails. If Node is fFun,
FunArgsg applying Fun to FunArgs should return a node name. The cookie on the client
node will be set to Cookie for this rpc operation (use to match the server node cookie).

cast(Node, Module, Function, Args) -> ok

Types:

� Node = NodeName | fFun, FunArgsg
� Fun = fun()
� FunArgs = term()
� NodeName = atom()
� Module = atom()
� Function = atom()
� Args = [term()]
� Reason = timeout | term()

82 Common Test



Common Test Reference Manual ct rpc

Evaluates apply(Module, Function, Args) on the node Node. No response is delivered
and the process which makes the call is not suspended until the evaluation is
compleated as in the case of call/[3,4]. If Node is fFun, FunArgsg applying Fun to
FunArgs should return a node name.

cast(Node, Module, Function, Args, Cookie) -> ok

Types:

� Node = NodeName | fFun, FunArgsg
� Fun = fun()
� FunArgs = term()
� NodeName = atom()
� Module = atom()
� Function = atom()
� Args = [term()]
� Reason = timeout | term()
� Cookie = atom()

Evaluates apply(Module, Function, Args) on the node Node. No response is delivered
and the process which makes the call is not suspended until the evaluation is
compleated as in the case of call/[3,4]. If Node is fFun, FunArgsg applying Fun to
FunArgs should return a node name. The cookie on the client node will be set to
Cookie for this rpc operation (use to match the server node cookie).
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ct snmp
Erlang Module

Common Test user interface module for the OTP snmp application

The purpose of this module is to make snmp configuration easier for the test case writer.
Many test cases can use default values for common operations and then no snmp
configuration files need to be supplied. When it is necessary to change particular
configuration parameters, a subset of the relevant snmp configuration files may be
passed to ct snmp by means of Common Test configuration files. For more specialized
configuration parameters, it is possible to place a “simple snmp configuration file” in the
test suite data directory. To simplify the test suite, Common Test keeps track of some of
the snmp manager information. This way the test suite doesn’t have to handle as many
input parameters as it would if it had to interface the OTP snmp manager directly.

The following snmp manager and agent parameters are configurable:

fsnmp,
%%% Manager config
[fstart manager, boolean()g % Optional - default is true
fusers, [fuser name(), [call back module(), user data()]g]g, %% Optional
fusm users, [fusm user name(), usm config()g]g,%% Optional - snmp v3 only
% managed agents is optional
fmanaged agents,[fagent name(), [user name(), agent ip(), agent port(), [agent con
fmax msg size, integer()g, % Optional - default is 484
fmgr port, integer()g, % Optional - default is 5000
fengine id, string()g, % Optional - default is "mgrEngine"

%%% Agent config
fstart agent, boolean()g, % Optional - default is false
fagent sysname, string()g, % Optional - default is "ct test"
fagent manager ip, manager ip()g, % Optional - default is localhost
fagent vsns, list()g, % Optional - default is [v2]
fagent trap udp, integer()g, % Optional - default is 5000
fagent udp, integer()g, % Optional - default is 4000
fagent notify type, atom()g, % Optional - default is trap
fagent sec type, sec type()g, % Optional - default is none
fagent passwd, string()g, % Optional - default is ""
fagent engine id, string()g, % Optional - default is "agentEngine"
fagent max msg size, string()g,% Optional - default is 484

%% The following parameters represents the snmp configuration files
%% context.conf, standard.conf, community.conf, vacm.conf,
%% usm.conf, notify.conf, target addr.conf and target params.conf.
%% Note all values in agent.conf can be altered by the parametes
%% above. All these configuration files have default values set
%% up by the snmp application. These values can be overridden by
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%% suppling a list of valid configuration values or a file located
%% in the test suites data dir that can produce a list
%% of valid configuration values if you apply file:consult/1 to the
%% file.
fagent contexts, [term()] | fdata dir file, rel path()gg, % Optional
fagent community, [term()] | fdata dir file, rel path()gg,% Optional
fagent sysinfo, [term()] | fdata dir file, rel path()gg, % Optional
fagent vacm, [term()] | fdata dir file, rel path()gg, % Optional
fagent usm, [term()] | fdata dir file, rel path()gg, % Optional
fagent notify def, [term()] | fdata dir file, rel path()gg,% Optional
fagent target address def, [term()] | fdata dir file, rel path()gg,% Optional
fagent target param def, [term()] | fdata dir file, rel path()gg,% Optional

]g.

The MgrAgentConfName parameter in the functions should be a name you allocate in
your test suite using a require statement. Example (where MgrAgentConfName =
snmp mgr agent):

suite() -> [frequire, snmp mgr agent, snmpg].

or

ct:require(snmp mgr agent, snmp).

Note that Usm users are needed for snmp v3 configuration and are not to be confused
with users.

Snmp traps, inform and report messages are handled by the user callback module. For
more information about this see the snmp application.

Note: It is recommended to use the .hrl-files created by the Erlang/OTP mib-compiler
to define the oids. Example for the getting the erlang node name from the erlNodeTable
in the OTP-MIB:

Oid = ?erlNodeEntry ++ [?erlNodeName, 1]

It is also possible to set values for snmp application configuration parameters, such as
config, server, net if, etc (see the “Configuring the application” chapter in the OTP
snmp User’s Guide for a list of valid parameters and types). This is done by defining a
configuration data variable on the following form:

fsnmp app, [fmanager, [snmp app manager params()]g,
fagent, [snmp app agent params()]g]g.

A name for the data needs to be allocated in the suite using require (see example
above), and this name passed as the SnmpAppConfName argument to start/3. ct snmp
specifies default values for some snmp application configuration parameters (such as
fverbosity,traceg for the config parameter). This set of defaults will be merged
with the parameters specified by the user, and user values override ct snmp defaults.
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DATA TYPES

agent config() = fItem, Valueg

agent ip() = ip()

agent name() = atom()

agent port() = integer()

call back module() = atom()

error index() = integer()

error status() = noError | atom()

ip() = string() | finteger(), integer(), integer(), integer()g

manager ip() = ip()

oid() = [byte()]

oids() = [oid()]

rel path() = string()

sec type() = none | minimum | semi

snmp app agent params() = term()

snmp app manager params() = term()

snmpreply() = ferror status(), error index(), varbinds()g

user data() = term()

user name() = atom()

usm config() = string()

usm user name() = string()

value type() = o(’OBJECT IDENTIFIER’) | i(’INTEGER’) | u(’Unsigned32’) | g(’Unsigned32’) |

var and val() = foid(), value type(), value()g

varbind() = term()

varbinds() = [varbind()]

varsandvals() = [var and val()]

Exports

get next values(Agent, Oids, MgrAgentConfName) -> SnmpReply

Types:

� Agent = agent name()
� Oids = oids()
� MgrAgentConfName = atom()
� SnmpReply = snmpreply()

Issues a synchronous snmp get next request.

get values(Agent, Oids, MgrAgentConfName) -> SnmpReply

Types:
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� Agent = agent name()
� Oids = oids()
� MgrAgentConfName = atom()
� SnmpReply = snmpreply()

Issues a synchronous snmp get request.

load mibs(Mibs) -> ok | ferror, Reasong

Types:

� Mibs = [MibName]
� MibName = string()
� Reason = term()

Load the mibs into the agent ’snmp master agent’.

register agents(MgrAgentConfName, ManagedAgents) -> ok | ferror, Reasong

Types:

� MgrAgentConfName = atom()
� ManagedAgents = [agent()]
� Reason = term()

Explicitly instruct the manager to handle this agent. Corresponds to making an entry in
agents.conf

register users(MgrAgentConfName, Users) -> ok | ferror, Reasong

Types:

� MgrAgentConfName = atom()
� Users = [user()]
� Reason = term()

Register the manager entity (=user) responsible for specific agent(s). Corresponds to
making an entry in users.conf

register usm users(MgrAgentConfName, UsmUsers) -> ok | ferror, Reasong

Types:

� MgrAgentConfName = atom()
� UsmUsers = [usm user()]
� Reason = term()

Explicitly instruct the manager to handle this USM user. Corresponds to making an
entry in usm.conf

set info(Config) -> [fAgent, OldVarsAndVals, NewVarsAndValsg]

Types:

� Config = [fKey, Valueg]
� Agent = agent name()
� OldVarsAndVals = varsandvals()
� NewVarsAndVals = varsandvals()
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Returns a list of all successful set requests performed in the test case in reverse order.
The list contains the involved user and agent, the value prior to the set and the new
value. This is intended to facilitate the clean up in the end per testcase function i.e. the
undoing of the set requests and its possible side-effects.

set values(Agent, VarsAndVals, MgrAgentConfName, Config) -> SnmpReply

Types:

� Agent = agent name()
� Oids = oids()
� MgrAgentConfName = atom()
� Config = [fKey, Valueg]
� SnmpReply = snmpreply()

Issues a synchronous snmp set request.

start(Config, MgrAgentConfName) -> ok

Equivalent to start(Config, MgrAgentConfName, undefined) [page 88].

start(Config, MgrAgentConfName, SnmpAppConfName) -> ok

Types:

� Config = [fKey, Valueg]
� Key = atom()
� Value = term()
� MgrAgentConfName = atom()
� SnmpConfName = atom()

Starts an snmp manager and/or agent. In the manager case, registrations of users and
agents as specified by the configuration MgrAgentConfName will be performed. When
using snmp v3 also so called usm users will be registered. Note that users, usm users
and managed agents may also be registered at a later time using
ct snmp:register users/2, ct snmp:register agents/2, and ct snmp:register usm users/2.
The agent started will be called snmp master agent. Use ct snmp:load mibs/1 to load
mibs into the agent. With SnmpAppConfName it’s possible to configure the snmp
application with parameters such as config, mibs, net if, etc. The values will be
merged with (and possibly override) default values set by ct snmp.

stop(Config) -> ok

Types:

� Config = [fKey, Valueg]
� Key = atom()
� Value = term()

Stops the snmp manager and/or agent removes all files created.

unregister agents(MgrAgentConfName) -> ok | ferror, Reasong

Types:

� MgrAgentConfName = atom()
� Reason = term()
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Removes information added when calling register agents/2.

unregister users(MgrAgentConfName) -> ok | ferror, Reasong

Types:

� MgrAgentConfName = atom()
� Reason = term()

Removes information added when calling register users/2.

update usm users(MgrAgentConfName, UsmUsers) -> ok | ferror, Reasong

Types:

� MgrAgentConfName = atom()
� UsmUsers = usm users()
� Reason = term()

Alters information added when calling register usm users/2.
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ct ssh
Erlang Module

SSH/SFTP client module.

ct ssh uses the OTP ssh application and more detailed information about e.g. functions,
types and options can be found in the documentation for this application.

The Server argument in the SFTP functions should only be used for SFTP sessions that
have been started on existing SSH connections (i.e. when the original connection type is
ssh). Whenever the connection type is sftp, use the SSH connection reference only.

The following options are valid for specifying an SSH/SFTP connection (i.e. may be
used as config elements):

[fConnType, Addrg,
fport, Portg,
fuser, UserNameg
fpassword, Pwdg
fuser dir, Stringg
fpublic key alg, PubKeyAlgg
fconnect timeout, Timeoutg
fkey cb, KeyCallbackModg]

ConnType = ssh | sftp.

Please see ssh(3) for other types.

All timeout parameters in ct ssh functions are values in milliseconds.

DATA TYPES

connection() = handle() | target name() (see module ct)

handle() = handle() (see module ct gen conn) Handle for a specific SSH/SFTP
connection.

ssh sftp return() = term() A return value from an ssh sftp function.
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Exports

apread(SSH, Handle, Position, Length) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

apread(SSH, Server, Handle, Position, Length) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

apwrite(SSH, Handle, Position, Data) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

apwrite(SSH, Server, Handle, Position, Data) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

aread(SSH, Handle, Len) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

aread(SSH, Server, Handle, Len) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()
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For info and other types, see ssh sftp(3).

awrite(SSH, Handle, Data) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

awrite(SSH, Server, Handle, Data) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

close(SSH, Handle) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

close(SSH, Server, Handle) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

connect(KeyOrName) -> fok, Handleg | ferror, Reasong

Equivalent to connect(KeyOrName, host, []) [page 93].

connect(KeyOrName, ConnType) -> fok, Handleg | ferror, Reasong

Equivalent to connect(KeyOrName, ConnType, []) [page 93].

connect(KeyOrName, ConnType, ExtraOpts) -> fok, Handleg | ferror, Reasong

Types:

� KeyOrName = Key | Name
� Key = atom()
� Name = target name() (see module ct)
� ConnType = ssh | sftp | host
� ExtraOpts = ssh connect options()
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� Handle = handle()
� Reason = term()

Open an SSH or SFTP connection using the information associated with KeyOrName.

If Name (an alias name for Key), is used to identify the connection, this name may be
used as connection reference for subsequent calls. It’s only possible to have one open
connection at a time associated with Name. If Key is used, the returned handle must be
used for subsequent calls (multiple connections may be opened using the config data
specified by Key).

ConnType will always override the type specified in the address tuple in the
configuration data (and in ExtraOpts). So it is possible to for example open an sftp
connection directly using data originally specifying an ssh connection. The value host
means the connection type specified by the host option (either in the configuration data
or in ExtraOpts) will be used.

ExtraOpts (optional) are extra SSH options to be added to the config data for
KeyOrName. The extra options will override any existing options with the same key in
the config data. For details on valid SSH options, see the documentation for the OTP
ssh application.

del dir(SSH, Name) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

del dir(SSH, Server, Name) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

delete(SSH, Name) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

delete(SSH, Server, Name) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()
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For info and other types, see ssh sftp(3).

disconnect(SSH) -> ok | ferror, Reasong

Types:

� SSH = connection()
� Reason = term()

Close an SSH/SFTP connection.

exec(SSH, Command) -> fok, Datag | ferror, Reasong

Equivalent to exec(SSH, Command, DefaultTimeout) [page 94].

exec(SSH, Command, Timeout) -> fok, Datag | ferror, Reasong

Types:

� SSH = connection()
� Command = string()
� Timeout = integer()
� Data = list()
� Reason = term()

Requests server to perform Command. A session channel is opened automatically for the
request. Data is received from the server as a result of the command.

exec(SSH, ChannelId, Command, Timeout) -> fok, Datag | ferror, Reasong

Types:

� SSH = connection()
� ChannelId = integer()
� Command = string()
� Timeout = integer()
� Data = list()
� Reason = term()

Requests server to perform Command. A previously opened session channel is used for
the request. Data is received from the server as a result of the command.

get file info(SSH, Handle) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

get file info(SSH, Server, Handle) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
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� Reason = term()

For info and other types, see ssh sftp(3).

list dir(SSH, Path) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

list dir(SSH, Server, Path) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

make dir(SSH, Name) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

make dir(SSH, Server, Name) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

make symlink(SSH, Name, Target) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

make symlink(SSH, Server, Name, Target) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()
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For info and other types, see ssh sftp(3).

open(SSH, File, Mode) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

open(SSH, Server, File, Mode) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

opendir(SSH, Path) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

opendir(SSH, Server, Path) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

position(SSH, Handle, Location) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

position(SSH, Server, Handle, Location) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()
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For info and other types, see ssh sftp(3).

pread(SSH, Handle, Position, Length) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

pread(SSH, Server, Handle, Position, Length) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

pwrite(SSH, Handle, Position, Data) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

pwrite(SSH, Server, Handle, Position, Data) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

read(SSH, Handle, Len) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

read(SSH, Server, Handle, Len) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()
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For info and other types, see ssh sftp(3).

read file(SSH, File) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

read file(SSH, Server, File) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

read file info(SSH, Name) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

read file info(SSH, Server, Name) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

read link(SSH, Name) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

read link(SSH, Server, Name) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()
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For info and other types, see ssh sftp(3).

read link info(SSH, Name) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

read link info(SSH, Server, Name) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

receive response(SSH, ChannelId) -> fok, Datag | ferror, Reasong

Equivalent to receive response(SSH, ChannelId, close) [page 99].

receive response(SSH, ChannelId, End) -> fok, Datag | ferror, Reasong

Equivalent to receive response(SSH, ChannelId, End, DefaultTimeout) [page 99].

receive response(SSH, ChannelId, End, Timeout) -> fok, Datag | ftimeout, Datag |
ferror, Reasong

Types:

� SSH = connection()
� ChannelId = integer()
� End = Fun | close | timeout
� Timeout = integer()
� Data = list()
� Reason = term()

Receives expected data from server on the specified session channel.

If End == close, data is returned to the caller when the channel is closed by the server.
If a timeout occurs before this happens, the function returns ftimeout,Datag (where
Data is the data received so far). If End == timeout, a timeout is expected and
fok,Datag is returned both in the case of a timeout and when the channel is closed. If
End is a fun, this fun will be called with one argument - the data value in a received
ssh cm message (see ssh connection(3)). The fun should return true to end the
receiving operation (and have the so far collected data returned), or false to wait for
more data from the server. (Note that even if a fun is supplied, the function returns
immediately if the server closes the channel).

rename(SSH, OldName, NewName) -> Result

Types:
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� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

rename(SSH, Server, OldName, NewName) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

send(SSH, ChannelId, Data) -> ok | ferror, Reasong

Equivalent to send(SSH, ChannelId, 0, Data, DefaultTimeout) [page 100].

send(SSH, ChannelId, Data, Timeout) -> ok | ferror, Reasong

Equivalent to send(SSH, ChannelId, 0, Data, Timeout) [page 100].

send(SSH, ChannelId, Type, Data, Timeout) -> ok | ferror, Reasong

Types:

� SSH = connection()
� ChannelId = integer()
� Type = integer()
� Data = list()
� Timeout = integer()
� Reason = term()

Send data to server on specified session channel.

send and receive(SSH, ChannelId, Data) -> fok, Datag | ferror, Reasong

Equivalent to send and receive(SSH, ChannelId, Data, close) [page 100].

send and receive(SSH, ChannelId, Data, End) -> fok, Datag | ferror, Reasong

Equivalent to send and receive(SSH, ChannelId, 0, Data, End, DefaultTimeout) [page
101].

send and receive(SSH, ChannelId, Data, End, Timeout) -> fok, Datag | ferror, Reasong

Equivalent to send and receive(SSH, ChannelId, 0, Data, End, Timeout) [page 101].

send and receive(SSH, ChannelId, Type, Data, End, Timeout) -> fok, Datag | ferror,
Reasong

Types:

� SSH = connection()
� ChannelId = integer()
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� Type = integer()
� Data = list()
� End = Fun | close | timeout
� Timeout = integer()
� Reason = term()

Send data to server on specified session channel and wait to receive the server response.

See receive response/4 for details on the End argument.

session close(SSH, ChannelId) -> ok | ferror, Reasong

Types:

� SSH = connection()
� ChannelId = integer()
� Reason = term()

Closes an SSH session channel.

session open(SSH) -> fok, ChannelIdg | ferror, Reasong

Equivalent to session open(SSH, DefaultTimeout) [page 101].

session open(SSH, Timeout) -> fok, ChannelIdg | ferror, Reasong

Types:

� SSH = connection()
� Timeout = integer()
� ChannelId = integer()
� Reason = term()

Opens a channel for an SSH session.

sftp connect(SSH) -> fok, Serverg | ferror, Reasong

Types:

� SSH = connection()
� Server = pid()
� Reason = term()

Starts an SFTP session on an already existing SSH connection. Server identifies the
new session and must be specified whenever SFTP requests are to be sent.

subsystem(SSH, ChannelId, Subsystem) -> Status | ferror, Reasong

Equivalent to subsystem(SSH, ChannelId, Subsystem, DefaultTimeout) [page 102].

subsystem(SSH, ChannelId, Subsystem, Timeout) -> Status | ferror, Reasong

Types:

� SSH = connection()
� ChannelId = integer()
� Subsystem = string()
� Timeout = integer()
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� Status = success | failure
� Reason = term()

Sends a request to execute a predefined subsystem.

write(SSH, Handle, Data) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

write(SSH, Server, Handle, Data) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

write file(SSH, File, Iolist) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

write file(SSH, Server, File, Iolist) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

write file info(SSH, Name, Info) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
� Reason = term()

For info and other types, see ssh sftp(3).

write file info(SSH, Server, Name, Info) -> Result

Types:

� SSH = connection()
� Result = ssh sftp return() | ferror, Reasong
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� Reason = term()

For info and other types, see ssh sftp(3).
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ct telnet
Erlang Module

Common Test specific layer on top of telnet client ct telnet client.erl

Use this module to set up telnet connections, send commands and perform string
matching on the result. (See the unix telnet manual page for information about how
ct telnet may be used specifically with unix hosts.)

The following default values are defined in ct telnet:

Connection timeout = 10 sec (time to wait for connection)
Command timeout = 10 sec (time to wait for a command to return)
Max no of reconnection attempts = 3
Reconnection interval = 5 sek (time to wait in between reconnection attempts)

These parameters can be altered by the user with the following configuration term:

ftelnet settings, [fconnect timeout,Millisecg,
fcommand timeout,Millisecg,
freconnection attempts,Ng,
freconnection interval,Millisecg]g.

Millisec = integer(), N = integer()

Enter the telnet settings term in a configuration file included in the test and
ct telnet will retrieve the information automatically.

DATA TYPES

connection() = handle() | ftarget name() (see module ct), connection type()g | target name(

connection type() = telnet | ts1 | ts2

handle() = handle() (see module ct gen conn) Handle for a specific telnet
connection.

prompt regexp() = string() A regular expression which matches all possible
prompts for a specific type of target. The regexp must not have any groups i.e.
when matching, re:run/3 shall return a list with one single element.
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Exports

close(Connection) -> ok | ferror, Reasong

Types:

� Connection = connection() (see module ct telnet)

Close the telnet connection and stop the process managing it.

A connection may be associated with a target name and/or a handle. If Connection has
no associated target name, it may only be closed with the handle value (see the open/4
function).

cmd(Connection, Cmd) -> fok, Datag | ferror, Reasong

Equivalent to cmd(Connection, Cmd, DefaultTimeout) [page 105].

cmd(Connection, Cmd, Timeout) -> fok, Datag | ferror, Reasong

Types:

� Connection = connection() (see module ct telnet)
� Cmd = string()
� Timeout = integer()
� Data = [string()]

Send a command via telnet and wait for prompt.

cmdf(Connection, CmdFormat, Args) -> fok, Datag | ferror, Reasong

Equivalent to cmdf(Connection, CmdFormat, Args, DefaultTimeout) [page 105].

cmdf(Connection, CmdFormat, Args, Timeout) -> fok, Datag | ferror, Reasong

Types:

� Connection = connection() (see module ct telnet)
� CmdFormat = string()
� Args = list()
� Timeout = integer()
� Data = [string()]

Send a telnet command and wait for prompt (uses a format string and list of arguments
to build the command). —————————————————————–

cont log(Str, Args) -> term()

end log() -> term()

expect(Connection, Patterns) -> term()

Equivalent to expect(Connections, Patterns, []) [page 106].

expect(Connection, Patterns, Opts) -> fok, Matchg | fok, MatchList, HaltReasong |
ferror, Reasong
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Types:

� Connection = connection() (see module ct telnet)
� Patterns = Pattern | [Pattern]
� Pattern = string() | fTag, string()g | prompt | fprompt, Promptg
� Prompt = string()
� Tag = term()
� Opts = [Opt]
� Opt = ftimeout, Timeoutg | repeat | frepeat, Ng | sequence | fhalt, HaltPatternsg
| ignore prompt

� Timeout = integer()
� N = integer()
� HaltPatterns = Patterns
� MatchList = [Match]
� Match = RxMatch | fTag, RxMatchg | fprompt, Promptg
� RxMatch = [string()]
� HaltReason = done | Match
� Reason = timeout | fprompt, Promptg

Get data from telnet and wait for the expected pattern.

Pattern can be a POSIX regular expression. If more than one pattern is given, the
function returns when the first match is found.

RxMatch is a list of matched strings. It looks like this: [FullMatch, SubMatch1,
SubMatch2, ...] where FullMatch is the string matched by the whole regular
expression and SubMatchN is the string that matched subexpression no N.
Subexpressions are denoted with ’(’ ’)’ in the regular expression

If a Tag is given, the returned Match will also include the matched Tag. Else, only
RxMatch is returned.

The function will always return when a prompt is found, unless the ignore prompt
options is used.

The timeout option indicates that the function shall return if the telnet client is idle
(i.e. if no data is received) for more than Timeout milliseconds. Default timeout is 10
seconds.

The repeat option indicates that the pattern(s) shall be matched multiple times. If N is
given, the pattern(s) will be matched N times, and the function will return with
HaltReason = done.

The sequence option indicates that all patterns shall be matched in a sequence. A
match will not be concluded untill all patterns are matched.

Both repeat and sequence can be interrupted by one or more HaltPatterns. When
sequence or repeat is used, there will always be a MatchList returned, i.e. a list of
Match instead of only one Match. There will also be a HaltReason returned.

Examples:
expect(Connection,[fabc,"ABC"g,fxyz,"XYZ"g],
[sequence,fhalt,[fnnn,"NNN"g]g]).
will try to match “ABC” first and then “XYZ”, but if “NNN” appears the function will
return ferror,fnnn,["NNN"]gg. If both “ABC” and “XYZ” are matched, the function
will return fok,[AbcMatch,XyzMatch]g.

expect(Connection,[fabc,"ABC"g,fxyz,"XYZ"g],
[frepeat,2g,fhalt,[fnnn,"NNN"g]g]).
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will try to match “ABC” or “XYZ” twice. If “NNN” appears the function will return
with HaltReason = fnnn,["NNN"]g.

The repeat and sequence options can be combined in order to match a sequence
multiple times.

get data(Connection) -> fok, Datag | ferror, Reasong

Types:

� Connection = connection() (see module ct telnet)
� Data = [string()]

Get all data which has been received by the telnet client since last command was sent.

open(Name) -> fok, Handleg | ferror, Reasong

Equivalent to open(Name, telnet) [page 107].

open(Name, ConnType) -> fok, Handleg | ferror, Reasong

Types:

� Name = target name()
� ConnType = connection type() (see module ct telnet)
� Handle = handle() (see module ct telnet)

Open a telnet connection to the specified target host.

open(KeyOrName, ConnType, TargetMod) -> fok, Handleg | ferror, Reasong

Equivalent to open(KeyOrName, ConnType, TargetMod, []) [page 107].

open(KeyOrName, ConnType, TargetMod, Extra) -> fok, Handleg | ferror, Reasong

Types:

� KeyOrName = Key | Name
� Key = atom()
� Name = target name() (see module ct)
� ConnType = connection type()
� TargetMod = atom()
� Extra = term()
� Handle = handle()

Open a telnet connection to the specified target host.

The target data must exist in a configuration file. The connection may be associated
with either Name and/or the returned Handle. To allocate a name for the target, use
ct:require/2 in a test case, or use a require statement in the suite info function
(suite/0), or in a test case info function. If you want the connection to be associated
with Handle only (in case you need to open multiple connections to a host for
example), simply use Key, the configuration variable name, to specify the target. Note
that a connection that has no associated target name can only be closed with the handle
value.

TargetMod is a module which exports the functions connect(Ip,Port,Extra) and
get prompt regexp() for the given TargetType (e.g. unix telnet).
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send(Connection, Cmd) -> ok | ferror, Reasong

Types:

� Connection = connection() (see module ct telnet)
� Cmd = string()

Send a telnet command and return immediately.

The resulting output from the command can be read with get data/1 or expect/2/3.

sendf(Connection, CmdFormat, Args) -> ok | ferror, Reasong

Types:

� Connection = connection() (see module ct telnet)
� CmdFormat = string()
� Args = list()

Send a telnet command and return immediately (uses a format string and a list of
arguments to build the command).

See also

unix telnet [page 109]
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unix telnet
Erlang Module

Callback module for ct telnet for talking telnet to a unix host.

It requires the following entry in the config file:

funix,[ftelnet,HostNameOrIpAddressg,
fport,PortNumg,
fusername,UserNameg,
fpassword,Passwordg]g.

To talk telnet to the host specified by HostNameOrIpAddress, use the interface
functions in ct, e.g. open(Name), cmd(Name,Cmd), ....

Name is the name you allocated to the unix host in your require statement. E.g.

suite() -> [frequire,Name,funix,[telnet,username,password]gg].

or

ct:require(Name,funix,[telnet,username,password]g).

Note that the fport,PortNumg tuple is optional and if omitted, default telnet port 23
will be used.

See also

ct [page 64], ct telnet [page 104]
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Index of Modules and Functions

Modules are typed in this way.
Functions are typed in this way.
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